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OMNI Flow Computers Inc.   

Our Mission 

OMNI Flow Computers Inc. sets the world’s standard for the design, development and 
manufacture of flow computers. For more than 30 years, we have supplied high-integrity 
equipment to offshore production facilities, oil and gas pipelines, terminals, refineries and 
petrochemical and gas plants worldwide.  

We are determined to be the best in what we do, which is driven by our commitment to providing 
an excellent customer experience. We offer a multi-tiered promise to our customers, employees 
and business partners, which includes: 

• Actively communicating with customers, integrators and original equipment manufacturers. 

• Collaborating with our customers to determine the best solutions. 

• Providing superior performance based on quality metrics. 

• Operating with integrity and traceability. 

• Providing continuous, relevant innovation that builds upon, rather than obsoletes, previous 
generations. 

Our Users 

Our products are currently being used worldwide at:  

• Offshore oil and gas production facilities.  

• Crude oil, refined products, liquefied petroleum gas (LPG), natural gas liquids (NGL) and gas 
transmission lines.  

• Storage, truck and marine loading/offloading terminals. 

• Refineries, petrochemical and cogeneration plants. 

Contact Us 

We are committed to our products, our people and our customers. To contact our corporate 
headquarters: 

Visit: OMNI Flow Computers, Inc. 

12320 Cardinal Meadow Dr.  

Suite 180 

Sugar Land, TX 77478 

http://www.omniflow.com/ 

Phone: 281-240-6161 

Fax: 281-240-6162 

E-mail (Sales): sales@omniflow.com 

E-mail (Support): helpdesk@omniflow.com 

http://www.omniflow.com/
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Copyright Information 

OMNI Flow Computers, Inc. owns the content of this user manual in its entirety, including but not 
limited to pictures, logos, trademarks and resources. OMNI Flow Computers, Inc. authorizes its 
customers to download and print this manual for professional information purposes only. 

OMNI Flow Computers, Inc. expressly prohibits the usage, copy, storage, distribution, 
modification or printing of this manual or its content for any other purpose without written consent. 

OMNI Flow Computers, Inc. believes that the information contained in this manual is accurate in 
all respects. However, OMNI Flow Computers, Inc. assumes no responsibility for any error or 
omissions in this document. OMNI Flow Computers, Inc. reserves the right to revise this 
document and to make changes from time to time in the content hereof without obligation of 
OMNI to notify any person or company of such revision or changes. This does not constitute in 
any way a commitment by OMNI to make such changes. OMNI Flow Computers, Inc. may issue 
a revision of this manual or a new edition of it to incorporate such changes.  

The OMNI Flow Computers, Inc. logo, “OMNI,” “OMNICOM”, “OMNICONNECT” and “Measure 
the Difference” are registered trademarks of OMNI Flow Computers, Inc., in the United States 
and other countries. All other trademarks are the property of their respective owners. 

Warranty, Licenses and Product Registration 

See the Terms and Conditions associated with your purchase order for the OMNI 4000/7000 flow 
computer warranty, licenses and product registration. 

Document Conventions 

Document conventions help you navigate through the information in this manual. Instructions are 
contained inside grey tables and use the following conventions:  

1.  Labeled cables and connections are 
bolded in the instructions: 

Connect I/O Cable A connector to CONN A 

on the motherboard. 

 

2.  Front panel screen and function key 
selections are bolded in the instructions: 

• Scroll to select Meter Run 1.  

• Press the Reports function key to run a 
report. 
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3.  OMNICONNECT® screen, window, field 
and button labels are bolded: 

• Click Apply to save any selections or 
any edits made to fields before moving 
to the next screen. 

• In the Setup Sites window, click Add 
Site to open the Setup 
Communications window.  

 

4.  A white box outlined in blue in an 
instructional step provides information that 
you need to know. 

 

 

5.  F1 in an instruction step is a prompt for 
you to go to OMNICONNECT Help for 
additional details to perform an action.  

Your cursor must be on the 
OMNICONNECT screen for F1 to open to 
the correct help content. 

 

 

 

 

 

 

Boxes with icons provide information. When an icon alerts you to a potential safety concern, 
observe these precautions to prevent injury to people or damage to equipment. 

 

The tip icon indicates additional information about the current topic. 

 

The bookmark icon indicates a reference to another guide in this series. 

 

WARNING:  

The warning icon indicates a definite risk of danger to personnel or damage to 
equipment. Failure to observe and follow proper procedures could result in serious 
or fatal injury to personnel or significant property loss or equipment damage. 

 

CAUTION:  

The caution icon indicates a potential risk of injury to personnel or damage to 
equipment. Take extreme care when performing operations or procedures preceded 
by this symbol. 

This will help you complete the 
action. 

Press F1 to access 
OMNICONNECT Help 
for assistance. 
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Earth Ground Requirements:  

The Earth Ground requirements icon reminds operators to verify that grounds are 
connected when there is a possibility of electrical shock. 

 

The electrostatic icon reminds operators to observe the precautions for handling 
electrostatic-sensitive devices. 

 

The recycle icon provides recycling instructions for the item. 
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1. The OMNI 4000/7000 Series 

The Operations and Maintenance Guide for the OMNI 4000 and OMNI 7000 series of flow 
computers includes:  

• An overview of the OMNI 4000/7000 flow computer. 

• OMNICONNECT software operations. 

• Front panel operations. 

• Maintenance instructions. 

• Hardware component troubleshooting. 

Review these instructions and guidelines to ensure a safe installation and startup of your OMNI 
4000/7000 flow computer. 

1.1 Users of this Guide 

As a user reference guide, the OMNI 4000/7000 Operations and Maintenance Guide is intended 
for an audience with knowledge of liquid and gas flow measurement technology. The user does 
not need to be an expert to use certain portions of this manual. However, some flow computer 
features require a certain degree of expertise and/or advanced knowledge of liquid and gas flow 
instrumentation and electronic measurement.  

This manual is written for: 

• Operators. 

• Advanced Technicians. 

• System and Project Managers.  

• Engineers and Programmers.  

Only qualified personnel should operate, configure and calibrate OMNI flow computers. 

1.2 Where Installed and Operated  

The OMNI 4000/7000 should have previously been installed in a climate-controlled environment 
that has access to stable back-up power. It can be operated locally from the front panel or 
remotely through Modbus communications.  

1.3 Certifications and Standards 

OMNI 4000/7000 flow computers have earned the following certifications: 

Nederland Meetinstituut (NMi) 

2004/108/EC Electromagnetic Compatibility Directive 

2004/22/EC Measuring Instruments Directive 

 OIML R117-1 Dynamic Measuring Systems for Liquids Other Than Water Standard, 
Edition 2007; part of MID Software Guide–Measuring 

 WELMEC 7.2 Software Guide Measuring Instruments Directive, Chapter P and 
Extensions L, T, S, D and I5, Edition 2015 
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Nederland Meetinstituut (NMi) 

 WELMEC 8.8 General and Administrative Aspects of the Voluntary System of 
Modular Evaluation of Measuring Instruments under the MID, Edition 
2:2012 

 EN 55011:2009+ 

A1:2010 
Industrial, Scientific and Medical (ISM) Equipment–Radio-Frequency 
Disturbance Characteristics  

 EN 61326-1:2013 Electrical Equipment for Measurement, Control and Laboratory Use–
EMC Requirements–Part 1: General Requirements 

 EN 12405-1:2005+ 
A2:2010 

Gas Meters - Conversion Devices - Part 1: Volume Conversion, Edition 
2005+A2:2010 

   

European Conformity (CE) 

2011/65/EU Restriction of Hazardous Substances in Electronic Equipment 
(RoHS2) Directive 

CE 93/68/EEC Marking as per European Conformity Directive 

  

TÜV Rheinland  

UL 60950-1:2007 Information Technology Equipment–Safety–Part 1: General 
Requirements 

UL 61010-1 Issued: 2004/07/12 Ed: 2 Rev: 2008/10/28 UL Standard for Safety 
Electrical Equipment for Measurement, Control, and Laboratory Use; 
Part 1: General Requirements 

CSA C22.2 61010-1 Issued: 2004/07/12 Ed: 2 (R2009) Safety Requirements for Electrical 
Equipment for Measurement, Control, and Laboratory Use Part 1: 
General Requirements, with general instruction No. 1:2008/10/28–
(R2009) 

ISO 9001:2015 Issued: 2018/08/15 Quality management system–Requirements 

  

American Petroleum Institute (API)  

Manual of Petroleum Measurement Standards (MPMS) 

 Chapter 4 Proving Systems 

 Chapter 5 Metering 

 Chapter 6 Metering Assemblies 

 Chapter 8 Sampling 

 Chapter 9 Density Determination 

 Chapter 11 Physical Properties Data (Volume Correction Factors) 

 Chapter 12 Calculation of Petroleum Quantities 

 Chapter 13 Statistical Aspects of Measuring and Sampling 

 Chapter 21 Flow Measurement Using Electronic Metering Systems 
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1.3.1 IEC Test Procedure Compliance 

To meet the standards/directives in Section 1.3, the OMNI 4000/7000 models comply with the 
IEC test procedures listed in this section. 

IEC 60068-2-1 Environmental testing–Part 2-1: Tests–Test A: Cold 

IEC 60068-2-2 Environmental testing–Part 2-2: Tests–Test B: Dry heat 

IEC 60068-2-47 Environmental testing–Part 2-47: Test–Mounting of specimens for vibration, 
impact and similar dynamic tests 

IEC 60068-2-64 Environmental testing–Part 2-64: Tests–Test Fh: Vibration, broadband 
random and guidance 

IEC 60068-3-1 Environmental testing–Part 3: Background information–Section One: Cold 
and dry heat tests 

IEC 60068-3-4 Environmental testing–Part 3-4: Supporting documentation and guidance–
Damp heat tests 

IEC 60654-2 Operating conditions for industrial-process measurement and control 
equipment–Part 2: Power 

IEC 61000-2-1 Electromagnetic Compatibility (EMC)–Part 2: Environment–Section 1: 
Description of the environment–Electromagnetic environment for 
low-frequency conducted disturbances and signaling in public power supply 
systems 

IEC 61000-4-1 Electromagnetic Compatibility (EMC)–Part 4-1: Testing and measurement 
techniques–Overview of IEC 61000-4 series 

IEC 61000-4-2 Electromagnetic Compatibility (EMC)–Part 4-2: Testing and measurement 
techniques–Electrostatic discharge immunity test 

IEC 61000-4-3 Electromagnetic Compatibility (EMC)–Part 4-3: Testing and measurement 
techniques–Radiated, radio-frequency, electromagnetic field immunity test 

IEC 61000-4-4 Electromagnetic Compatibility (EMC)–Part 4-4: Testing and measurement 
techniques–Electrical fast transient/burst immunity test 

IEC 61000-4-5 Electromagnetic Compatibility (EMC)–Part 4-5: Testing and measurement 
techniques–Surge immunity test 

IEC 61000-4-6 Electromagnetic Compatibility (EMC)–Part 4-6: Testing and measurement 
techniques–Immunity to conducted disturbances, induced by 
radio-frequency fields 

IEC 61000-4-8 Electromagnetic compatibility (EMC)–Part 4-8: Testing and measurement 
techniques–Power frequency magnetic field immunity test 

IEC 61000-4-17 Electromagnetic Compatibility (EMC)–Part 4-17: Testing and measurement 
techniques–Ripple on D.C. input power port immunity test 

IEC 61000-4-29 Electromagnetic Compatibility (EMC)–Part 4-29: Testing and measurement 
techniques–Voltage dips, short interruptions and voltage variations on D.C. 
input port immunity tests 

IEC 61000-6-1 Electromagnetic compatibility (EMC)–Part 6-1: Generic standards–
Immunity for residential, commercial and light-industrial environments 

IEC 61000-6-2 Electromagnetic compatibility (EMC)–Part 6-2: Generic standards–
Immunity for industrial environments 

IEC 61000-6-4 Electromagnetic compatibility (EMC)-Part 6-4: Generic standards–Emission 
standard for industrial environments 
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1.3.2 Measurement Security and Firmware Downloads (WELMEC 7.2 Extension D)  

The OMNI 4000 and 7000 models have 16 password-protected access levels for protecting 
configuration parameters and for firmware downloads. When software sealing for parameters and 
firmware is applied, the highest level is reserved for Weights and Measures Agents and other 
agencies that act in the same way. Through software sealing, all communication ports can be set 
to “read-only.” 

Only licensed firmware files can be transmitted.  

This method of firmware transmission meets all requirements of WELMEC 7.2 2015 Extension D, 
Software Guide—Measuring Instruments Directive. 

1.4 Calculations 

The OMNI 4000/7000 includes, but is not limited to, support for the following calculations: 

Liquid (U.S. Units) 

API MPMS CH. 11.1 (2007)  

Commodity Types: 

• Crude Oil 

• Refined Products 

• Lubricating Oil 

• Special Applications 

Crude Oil Historical Tables  

(API STD 2540/ASTM D1250, 1952 
edition) 

• Table 23/24 

• Table 5/6 

ASTM D1555 Aromatic Hydrocarbons LPGs and NGLs 

• API MPMS CH. 11.2.4 - 23E/24E – 
(GPA TP27) 

• API MPMS CH. 14.7/14.4 – GPA 2145-
16*  

Mass Calculation  

Liquid (Metric Units)  

API MPMS CH. 11.1 (2007) 

• Crude Oil 

• Refined Products 

• Lubricating Oil 

• Special Applications 

Crude Oil Historical Tables  

(API STD 2540/ASTM D1250, 1952 
edition) 

Table 53/54 

ASTM D1555M Aromatic Hydrocarbons LPGs and NGLs  

• API MPMS CH. 11.2.4-53E/54E-(GPA 
TP27M) 

 

Mass Calculation Alcohols 

• Alcohol (ABNT NBR 5992:2008) 

• Alcohol (OIML) R22 
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Gas (U.S. Units) 

Flow Calculations 

DP Meters 

• API MPMS CH. 14.3 (AGA-3): 2012  

• ASME MFC 3M (Non-Flange DP 
types) 

Pulse Meters 

• AGA-7: 2006 

Density Calculations 

AGA-8 1994 

• Method 1-Detailed Analysis 

• Method 2-HV/SG/CO2 

• Method 3-SG/N2/CO2 

Heating Value Calculation 

• GPA 2172 2009 

• ISO 6976 60/60F 

• AGA 5 2009 

Speed of Sound 

• AGA-10 

 

Viscosity Calculation 

• LBC  

Isentropic Exponent Calculation 

• Estimated 

• AGA-10 

Gas (Metric Units) 

Flow Calculations 

DP Meters 

• ISO 5167:2003 

• API MPMS CH. 14.3 (AGA-3): 2012 

Pulse Meters 

• AGA-7: 2006 

Density Calculations: 

AGA-8 1994  

• Method 1-Detailed Analysis 

• Method 2-HV/SG/CO2 

• Method 3-SG/N2/CO2 

Heating Value Calculation 

• ISO 6976 (1995) 

• GPA 2172 (2009) 

• AGA-5 (2009) 

SGERG 1988 

• Method 2-HV/N2/SG/H2 

• Method 3-N2/CO2/SG/H2 

• Method 4-HV/N2/CO2/H2 

Viscosity Calculation 

• LBC 

ISO 12213-3 2006 (SGERG) 

• Method 1-HV/N2/SG/H2 

Isentropic Exponent Calculation 

• Estimated 

• AGA-10 

Speed of Sound 

• AGA-10 

 

 

  

 

*API MPMS CH. 14.7/14.4 is available with Firmware version 2.11 and higher for the US Liquid K-
Factor Linearization Application. It requires the purchase of an Advanced firmware license with 
the API MPMS CH. 14.7/14.4 feature enabled.  
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1.5 Equipment Overview 

OMNI 4000s and 7000s are microprocessor-based flow computers that perform liquid and gas 
flow calculations in accordance with the methods listed in Section 1.4 Calculations.  

The flow computer connects to field transmitters in single and multiple Meter Run applications 
to monitor: 

• Liquid and gas flow measurements in the pipeline. 

• Custody transfer applications. 

The flow computer calculates flow values and displays additional data and measurement 
information. This data and information can be transmitted over communication channels and 
printed, as needed.  

In addition, audit trail logs are available for registering changes to measurement parameters and 
firmware updates. The audit trail can be printed directly from the front panel of the flow computer 
or viewed with the OMNICONNECT software when connected to a computer.  

All input/output (I/O) modules are quality tested and temperature trimmed to optimize analog 
inputs before the flow computer is shipped. A label containing information such as the system 
serial number and model number is located on the inner chassis or on the outer cover in the case 
of the panel mount configuration. 

On-site, OMNI 4000/7000 flow computers are configurable, but the firmware code is not user 
programmable. We do this to prevent the modification of WELMEC-approved metrologically 
relevant areas of the software code. If firmware modifications were allowed, they would render an 
existing EC-evaluation certification invalid.  

With an OMNI flow computer, the factory-programmed software does not need modification in the 
field. This preserves the integrity of existing certifications and provides assurance that software 
and firmware have been validated and cannot be modified. 
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Every OMNI 4000/7000 flow computer has the following components and features: 

Hardware  

• 7201 central processing unit (CPU) 

• 4.3-inch (10.922 cm) Color LCD with 800 
x 480 resolution 

• USB Mini-B port on the front panel for 
configuring the flow computer using 
OMNICONNECT 

• USB-A Host port on the front panel for 
updating the OMNI CPU firmware using a 
memory stick 

• USB Mini-B port on the CPU for 
configuration or updating the OMNI CPU 
firmware using OMNICONNECT 

• Dual Ethernet (DE) module with: 

− 2 onboard RJ-45 100 Mbps Ethernet 
jacks 

− 10 Mbps using the back panel 

• Expandable to allow for 2 DE modules (4 
physical Ethernet ports for a total of 32 
virtual connections).  

• Expandable to allow for up to 10 Serial 
ports with different combinations of DE 
and S cards. Must purchase separately. 

• Digital I/O Multiplexer (DM) module with 
10 independent channels 

• Digital I/O channels that support up to 3 
externally installed Digital Terminals 
(DTs), which can be used in sequence. 
Each DT contains 16 I/O points. DTs are 
optional purchase items.  

• 2 local printers, which can be connected 
to any RS-232 Serial port 

Firmware  

• All firmware applications in one 
programming file 

• Daily, Batch, and Prove Historical 
Reports and for gas applications, a 
Detailed Daily report:  

− The 35 most recent reports are 
stored in the CPU memory.  

− Older reports are stored on the SD 
card, which has capacity of 8 GB 
of data.  

− 2 GB is allocated for each 
report type. 

• Audit trail and alarm reports 

• User database mapping providing 
standardization of local data maps or 
custom interfacing*  

• Programmable Boolean and variable 
statements–128 statements with a 
32-character length allowing technical 
flexibility for adding custom functions  

• Support for 6 Meter Runs, which can be 
configured for Liquid and Gas 
measurement independently 

• 2 sets of detector switches for dual 
prover volumes 

• Proves based on run repeatability or 
random uncertainty** 

• Selectable Master Meter prove meter 

• Programmable security settings: 

− 1 Administrator and 16 users with 
separate permissions 

− Different passwords for users and 
data system connections 

• A full audit feature, with separate reports 
for the system and measurement audits  

• Support for: 

− SSL* 

− Dual Stations* 

− User Database Mapping* 

− A Gas/Liquid combination mode* 

*These features require the Standard firmware license (not included in the Basic firmware license). 

**Random Uncertainty is available with Firmware version 2.11and higher for the US Liquid K-Factor Linearization Application. It requires the 

purchase of an Advanced firmware license with the Prover Uncertainty feature enabled. 
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1.6 Safety  

1.6.1 Basic Electric Safety  

 

Observe precautions for handling electrostatic-sensitive devices. 

Take basic electrical safety precautions to prevent injury and equipment damage: 

☐ Keep the area around the equipment clean and free of clutter. 

☐ Verify that the power is not connected to the system when installing or removing main 

system components, including I/O modules. 

 

CAUTION:  

Do not hot swap I/O modules. Electrical shock may occur, resulting in injury to 
personnel and damage to the flow computer or connected field devices/control 
systems. 

 

☐ Connect the power using a readily accessible disconnect device certified as being safe for 

the area. 

☐ If an electrical accident occurs, disconnect the power to the system by removing the plug(s) 

from the outlet(s). Some systems may have multiple power cords that connect to more than 
one outlet. 

1.6.2 Electrical Grounding Requirements 

Follow these requirements for grounding equipment: 

☐ The rack or cabinet that will house the flow computer must be properly Earth Grounded before 

installation. 

☐ An Earth-Grounded electrical outlet must be available for all power cables. 

☐ If using a power cable other than the factory-supplied cable, the power cord must include an 

Earth-Grounding pin. 

 

Earth Ground Requirements: Do not apply power before confirming that grounds 
are connected. Electrical shock can cause serious or fatal injury. Follow the National 
Electrical Code (NEC) and local codes for the safe installation of this equipment. 

☐ To minimize the effects of electrical transients, the outer chassis of the flow computer must 

have a secure Earth Ground. 
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1.6.3 Safety Labels 

Table 1-1 describes the safety labels that are posted on the OMNI 4000/7000 flow computer. 

Table 1-1: Safety Label Descriptions 

 

The No Vertical Mount safety label is located on the side of the National Electrical 
Manufacturers Association (NEMA) chassis where the I/O ribbon cables are connected and 
provides recommendations for mounting the NEMA chassis. 

The label reads:  

CAUTION: NO Vertical Mount! 

• Mount the NEMA Chassis horizontally for proper heat transfer. 

• Mount chassis to bonded metal surface. 

• Bonded metal surface shall be provided with a safety earth path. 

• Avoid mounting in drafts that cause fluctuations in temperature. 

 

The Earth Ground safety label is located below the Earth Ground connection on the chassis. 

It indicates where to connect the flow computer to safety Earth Ground. 

 

The alternating current (AC) voltage safety label is located below the Serial Number label on 
the Panel mount chassis and on the side of the NEMA chassis. 

It denotes the specified AC voltage at which the flow computer operates. 

 

The fuse safety label is located on the panel mount back panels and provides the proper fuse 
specifications for the OMNI 4000/7000. 



OMNI 4000/7000 Operations and Maintenance Guide – Rev F 

 
2-1 OMNI 4000/7000 Overview 

 
 

2. OMNI 4000/7000 Overview 

The OMNI 4000/7000 flow computer is supplied with firmware and Windows PC configuration 
software that allow a single flow computer to perform a wide range of flow measurement tasks 
simultaneously, including: 

• Multiple Meter Run totalizing, batching, proving and data archiving. 

• Flow and control. 

• Communications protocols (selectable) to directly interface with Distributed Control Systems 
(DCSs), Programmable Logic Controllers (PLCs) and Supervisory Control and Data 
Acquisition (SCADA) host systems. 

The flow computer Modbus database numbers thousands of data points and provides tight 
communications coupling between the SCADA and the metering system. 

2.1 Hardware 

Front Panel 

The front panel of the flow computer features an active alarm Light-emitting Diode (LED), a color 
graphics display and a 25-key keypad for navigation of the menu system, data selection and data 
entry. The front panel provides the capability to configure system parameters, view flow data, 
perform I/O calibrations and print reports. 

Back Panel 

All signal I/O terminals and power connector/terminals are located on the back panel. The 
OMNI 4000 has four I/O terminal blocks and the OMNI 7000 has ten I/O terminal blocks. 

All flow measurement inputs are first received at the back panel and then through plug-in I/O 
combination (combo) modules. Four types of combo modules are available: A, B, E and E/D.  

Flow computers may be used to interface with any approved compatible 4-20 mA or 1-5 V 
temperature, pressure and differential pressure transmitter from the back panel. They can also 
receive direct inputs from 4-wire, 100-ohm Resistance Temperature Detectors (RTDs), which 
conform to either Deutsches Institut für Normung (DIN) IEC 751 or American curves. 

Pulse inputs from any approved turbine, positive displacement, or Coriolis mass flow meter may 
be used. 

Chassis 

The chassis houses the I/O modules, the motherboard, the CPU and the power supply.  

CPU Module 

All custody transfer measurement programs and configurations can be stored in non-volatile 
memory for up to 10 years without power. This method prevents damage caused by electrical 
noise or tampering with the integrity of calculation specifications, and it does not rely on a battery. 
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2.2 Firmware 

Real-time Operating System 

The real-time operating system and dual Ethernet adapt to load placement, which creates a 
high-speed, multitasking environment and quick turnaround on all communications. The operating 
system adapts to meet increased demand, and its pre-packaged, certified and standardized code 
makes the software easier to maintain. 

Cycle Time 

The flow computer performs all time-critical measurement functions every 500 milliseconds or 
less. For example, the Digital MUX, pulse density and double chronometry critical functions occur 
every 10 milliseconds. This cycle time makes measurement calculations more accurate and 
permits faster pipeline operations response for critical control functions such as opening or 
closing valves. 

On-line Diagnostics and Calibration 

Diagnostic software is built into the system so that a technician can debug a possible problem 
remotely without interrupting on-line measurement. Technicians can also remotely test Modbus 
communications through a unique Modbus register master simulator that is built into the software. 

The flow computer has an automatic, two-point calibration system. The operator inputs the high 
and low points of the calibrator into the flow computer, which then calculates the calibration. 

CPU Firmware  

Firmware is stored in flash memory, which is located in the CPU module. The firmware contains 
the liquid and gas flow calculations for both metric and US standard units. 

Firmware can be updated in two ways: 

• With a factory-provided Universal Serial Bus (USB) flash drive 

• Through OMNICONNECT when connected to the USB port on the CPU 

2.3 Software 

OMNICONNECT® 

Online or offline configuration of OMNI 4000 and 7000 models is possible using a personal 
computer that can run the OMNICONNECT software. This software manages the flow computer’s 
configuration, operation, security setup, and supports the updating of the CPU’s firmware. 
OMNICONNECT can connect to the flow computer via the Ethernet ports, Serial ports, the front 
panel USB port and the CPU USB port. 

OMNICONNECT requires a license to run. OMNICONNECT is licensed to the individual PC or 
laptop. 
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Figure 2-1: OMNICONNECT® 

OMNIPANEL 

The OMNIPANEL software remotely replicates all the functionality of the OMNI 4000/7000 flow 
computer’s front panel for times when physical access to the flow computer is not possible. 
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Figure 2-2: OMNIPANEL 
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Network Utility 

Network Utility is part of the OMNI software suite and is used to view the configuration settings of 
the DE module and to upgrade the DE module firmware. Although the IP addresses of the DE 
Module can be modified, the program cannot be used to modify the remaining DE module 
configuration settings. This must be completed through OMNICONNECT, although some of the 
settings required to establish communications can be modified from the flow computer front 
panel. 

 

Figure 2-3: Network Utility 

OMNI Modbus Tester 

The OMNI Modbus Tester is a Modbus Master that can test a device that implements a Modbus 
slave protocol, such as an OMNI flow computer. The tester can communicate using Modbus over 
TCP, RTU or ASCII protocol. The register addressing can be Logical (1 float register is 4 bytes), 
Register (two consecutive 16-bit registers are combined to make 1 float) or Modicon compatible 
(two consecutive 16-bit registers are combined to make 1 float and the float bytes are swapped 
from ‘aa bb cc dd’ to ‘cc dd aa bb’).  

The tester supports all the major function codes as well as user-defined function codes. It also 
supports a wide range of data types including Booleans and strings. You can repeat 
transmissions of one register with a delay and set up a list of registers for one transmission or 
repeated transmissions based on continuous, number of times, or over a date/time range. 
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Figure 2-4: OMNI Modbus Tester 
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3. OMNICONNECT® Operations 

 

At any point while using OMNICONNECT, you may press F1 on your keyboard 
to access OMNICONNECT Help. This gives more detailed descriptions of each 
tree item and screen. Your cursor must be on the tree item or screen of interest 
to open the corresponding help information. 

 

3.1 Communications 

After the OMNICONNECT software is activated, connect the software on your PC to the flow 
computer through a selected communication method.  

 

If you have previously configured Serial or Ethernet ports through the flow 
computer’s front panel (see Section 4.3 Configuring Communications Ports 
(Front Panel) in the Installation Guide), you still must create sites to match them 
in OMNICONNECT to communicate with those ports, as they are not 
created automatically. 

 

See Section 4.7.2 Setup Sites in the Installation Guide for instructions on how 
to configure sites and units within OMNICONNECT to allow access to the flow 
computer or access the OMNICONNECT Help File under the How To section. 

3.2 Security 

 

See Section 4.8 Security Setup in the Installation Guide for further instructions 
on how to configure user permissions and port security, if needed. 

3.2.1 Enter Password 

The password window appears when connecting to an OMNI flow computer from 
OMNICONNECT or OMNIPANEL. Click the drop-down arrow and select your 
Administrator-assigned User ID from the list of available names. Enter your password and 
press OK. 
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The following rules apply to passwords: 

• The default timeout for a user password is 30 minutes, but the Administrator can modify 
the timer. 

• If five invalid password attempts are made within a two-minute period, the port will be locked 
for one minute. 

3.2.2 Lost Password 

If a user loses an OMNICONNECT or front panel-access password, contact your company’s flow 
computer Administrator to have the password reset. The Administrator can set a new password 
and inform the user.  

If the Administrator has lost the Administrator password or needs further assistance, contact the 
OMNI Help Desk at helpdesk@omniflow.com. 

3.2.3 User Permissions 

Any operation in the flow computer require specific user permissions as selected by the system 
Administrator. In both the front panel and OMNICONNECT, users must enter their password to 
access any editable items. 

3.3 Application Types 

When OMNICONNECT opens to the Startup Screen, choose from the following options (Figure 
3-1): 

• Select an option from the eight application types presented in the window to open a 
“New” file. 

• Use the "Recent Files" option to select a configuration file that was recently opened. 

• Select "Open" to open an existing configuration file. 

• Select "Connect" to connect to an OMNI flow computer.  

You can also set the preferences to not display this screen upon startup and default to the last 
application used. 

 

Figure 3-1: Startup Screen 

mailto:helpdesk@omniflow.com
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OMNICONNECT currently supports three different pulse type flow meters: Turbine, Positive 
Displacement and Coriolis Mass Pulse. Gas product applications have the added option of 
configuring orifice differential pressure type flow meters. 

From the Startup Screen, you can also choose whether to use a K-Factor (KF) multi-point curve 
or a Meter Factor (MF) multi-point curve for applying a correction factor to the flow pulses in liquid 
measurement. The gas applications always use the K-Factor curve option for pulse type 
flow meters. 

When selecting a liquid KF curve application, you have the option for each volumetric pulse flow 
meter to configure a curve with up to 12 points for KFs and associated flow meter frequencies. 
For mass pulse flow meters, certain Coriolis flow meter models can use a curve with up to 12 
points for MFs and associated Reynolds Numbers and Flow Rates. When selecting a liquid MF 
curve application, you can configure a curve with up to 12 MFs and associated flow rates for each 
of the six flow meters under each of the 32 products. 

3.4 Configurations 

3.4.1 Meter Run Configurations 

To create a Meter Run or make changes to current settings, follow these instructions: 

1.  In the Actions ribbon, click Configure.  

 

2.  a. To make changes the settings of an 
existing Meter Run go to Step 4. 

b. To create Meter Runs or edit the 
attributes of an existing Meter Run, 
click on General Setup in the 
Configure tree.  

c. Click on the Equipment List tab. 
d. Select the number of Meter Runs 

needed and their attributes, or edit the 
selections of the current Meter Run. 
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3.  When finished, click Apply to save your 
changes. The Meter Runs you selected will 
now appear in the Configure tree. 

 

4.  To make changes to an existing Meter 
Run, expand that Meter Run in the 
Configure tree. 

 

 
 

5.  Click on any of the items listed under the Meter Run in the tree to make changes to the 
settings, as needed. 

 

  

6.  Continue to edit Meter Run settings, as 
needed, by repeating Steps 4 and 5. 

 

 

You may see different items listed 
in the tree, depending on your 
selections in the Equipment List. 
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3.4.2 Station Configurations 

To create a Station or make changes to current settings, follow these instructions: 

1.  In the Actions ribbon, click Configure.  

 

2.  a. To make changes to an existing 
Station, go to Step 4. 

b. To create a Station, click on General 
Setup in the Configure tree.  

c. Click on the Equipment List tab. 
d. Select either one or both Stations, as 

needed. 
 

 

 

3.  When finished configuring the Stations, 
click Apply to save your changes. The 
Stations you selected will now appear in 
the Configure tree. 

 

4.  To make changes to an existing Station, 
expand that Station in the Configure tree. 

 

 

 

You may see different items listed 
in the tree, depending on your 
selections in the Equipment List. 
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5.  Click on any of the items listed under the 
Station in the tree to make changes to the 
settings, as needed. 

 

 
 

 

 

6.  If you created the second Station in the 
Equipment List (Step 2) and need to 
make changes, repeat Steps 4 and 5 for 
the second Station. 

 

3.4.3 Products Configuration 

Some products will likely be configured during installation of the flow computer. However, updates 
may need to be made when new products enter the pipeline. 

Liquid Products 

To configure liquid products, follow these instructions: 

1.  In the Actions ribbon, click Configure.  
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2.  a. Select Products in the Configure 
tree in the left panel. 

b. Expand the item to see the entire list 
of products. 

 

 

 

3.  a. Select a product in the tree to display its configuration options in the screens on 
the right.  

b. In the Product tab, enter a name or identifier (up to 32 character ASCII string) for the 
product in the Name group. 

c. Enter a numeric identifier in the Numeric Name group, as needed. 

 

4.  Select the Density Correction Factor 
(DCF) to use when running this product.  

 

 

 

 

 

 

 

 

 

For liquid applications, there are up 
to 32 configurable products. You do 
not have to use or configure all of 
them.  

If a Meter Run or Station has 
been set up for density/gravity, 
the DCF A and B values can be 
found and/or adjusted at 
Configure tree > Meter 
Run/Station (#) item > 
Density options > Setup tab. 
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The calibration result of some densitometer devices, also known as a pycnometer 
test for establishing a DCF, varies with the product. Density Factor A and B are 
associated with the specific densitometer assigned to a Meter Run. The Product 
DCF is associated with the specific product selected. 

5.  a. If the product requires a unique DCF 
other than Factors A or B, choose 
Product DCF. 

b. The Density Correction Factors 
group is now visible. Enter the 
individual DCFs for this product for 
each enabled Meter Run or Station. 

 

 

6.  a. Enter the Meter Factors for each 
Meter Run if you want to update them 
manually (optional).  

b. When you are finished, click Apply to 
save the changes. 

 

 

 

If you choose to automatically update Meter Factors after a successful prove 

sequence, go to Section 0  

 

Prove Configuration, Step 11. You do not have to edit these values manually. 

 

You can also manually enter Meter Factors from the front panel of the flow computer 
using the Operate/Edit MF menu. 

The Density Correction Factors 
group must have the Product 
DCF option selected and the 
meter or station must have a 
valid density I/O point assigned 
to become enabled. 
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7.  a. Click on the Measurement Algorithm 
tab.  

b. Select the Table or measurement 
algorithm to use for this product, 
based on the product specifications.  

c. Click Apply to save the selection. 

  

8.  a. Click on the Setup tab. Only the items 
applicable to the Table you chose in 
Step 7 will be enabled. 

b. Enter or select the required 
parameters on this screen.  

c. When you are finished, click Apply to 
save the changes. 

 

  

 

9.  Continue to move down the list of products 
in the tree to configure new products or 
make changes to existing products.  

 

 

 

 

 

 

 

  

 

After these specific products are 
configured, you can select them 
when setting up batch sequences 
in the batch stack queues (see 
Section 3.6.1 Batch Setup and 
Scheduling Configuration). 
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10.  a. If the flow computer is equipped with 
a Gas Chromatograph for liquid 
applications (selected on the 
Equipment List screen found on 
Configure tree > General Setup item 
> Equipment List tab), select Gas 
Chromatograph on the tree.  

 

 

11.  a. Fill in the information on all three gas 
chromatograph screens. 

b. When you are finished, click Apply to 
save the changes. 

 

 

12.    

 

Gas Products 

To configure gas fluid products, follow these instructions: 

1.  In the Actions ribbon, click Configure.  

 

2.  a. Select Fluid Products in the 
Configure tree. 

b. Expand the item to see the entire list 
of products. 

 

 

 

 

 

 

For gas applications, six products 
can be configured. You do not have 
to use or configure all of them. 
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3.  Select a product in the tree to display its configuration options in the screens on the right. 

 

4.  a. Select the Fluid Type from the 
drop-down list in the Fluid Setup 
group. 

b. Enter a name or identifier (up to 32 
ASCII characters). 

c. Enter a numeric identifier in the 
Numeric Name group, as needed. 

 

5.  In the center column of the Setup screen, 
select the Density Method for this 
product.  

 

 

 

 

 

 

 

 

 

6.  a. Select how to handle neo-Pentane 
from the AGA-8 neo-Pentane 
Handling drop-down list. 

b. Click the check box if you want to 
enable the AGA-10 Calculation. 

 

This selection turns on or off 
multiple fields and tabs associated 
with the selection, namely in the 
far-right column of this screen and 
in the 1994 Analysis tab. 
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7.  In the left column of the Setup screen, 
enter the override values and select the 
preferred calculations for this product. 

 

 

8.  Depending on which Density Method you 
chose, the available applications in the 
right-hand column may change. 

a. Click on any of the HV, SG, N2 or 
CO2 buttons to open their 
configuration windows, and assign 
source inputs, alarms and overrides, 
as needed. 

b. Click OK to save the changes and 
close the window. 

 

 

 

 

Viscosity and Isentropic 
Exponent information are required 
only for differential pressure 
devices.  

Configuration of these selections is 
optional and is not necessary if 
these values are being provided by 
a Gas Chromatograph (GC). 
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9.  When you are finished with the Setup 
screen, click Apply to save your changes. 

 

10.  a. Click on the 1994 Analysis tab. 
Depending on which Density Method 
you chose, the analysis overrides 
available on this screen may change. 

b. Enter the necessary GC Component 
Analysis Overrides.  

 

 

 

 

 

11.  Continue to move down the list of products 
in the tree to configure new products or 
make changes to existing products.  

 

12.  a. If the flow computer is equipped with 
a Gas Chromatograph (selected on 
the Equipment List screen found on 
Configure tree > General Setup item 
> Equipment List tab), select and 
expand Gas Chromatograph on the 
tree.  

b. Select GC 1 to display its 
configuration settings in the screens 
on the right.   

These override values can be 
obtained by a laboratory analysis of 
the product, or they can be written 
through Modbus writes. 
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13.  a. Fill in the information on both gas chromatograph screens. 

b. When you are finished, click Apply to save the changes. 

 

 

For GC 1, pay particular attention to the selections in the GC Strategy group. If you 
have a redundant GC, the last two options in the list will be active. If you choose the 
Use Redundant GC 2 on GC 1 failure option, and both GCs fail, the default setting 
for the flow computer is to use the Product Override. 

 

14.  Repeat Steps 12 and 13 for GC 2 if you 
have redundant gas chromatographs.  
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Assign Gas Product to Meter Run 

In liquid applications, products are assigned to Meter Runs using batches and batch stacks. Go to 
Section 3.6  

Batch Operations for more information on batches.  

To assign a gas fluid product to a Meter Run, follow these instructions: 

1.  In the Actions ribbon, click Configure.  

 

2.  a. Expand a Meter Run in the 
Configure tree. 

b. Click on Flowmeter to display its 
configuration options in the screens 
on the right. 

  

 

3.  In the lower right-hand corner of the Setup 
screen, select a product number in the 
Flow Stream group to assign that product 
stream to that Meter Run. 

 

 

 

 

 

 

 

 

 

4.  When you are finished with the Setup 
screen, click Apply to save your changes. 

 

5.  Continue to assign products to other Meter 
Runs, as needed. 

 

 

  

This number corresponds to the 
numbered gas fluid product 
(1 through 6) listed under Fluid 
Products in the Configure tree. 
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3.5 Proving Functions 

3.5.1 Prove Types 

The three types of liquid proving options are: Conventional, Pulse Interpolation and Master Meter 
(gas only supports Master Meter). 

Use the Conventional prover option or ball prover if more than 10,000 flow meter pulses are 
accumulated between detectors. If less than 10,000 pulses are accumulated between detectors, 
use Pulse Interpolation (double chronometry) proving, also known as compact or small volume, 
for improved pulse resolution.  

 

An E-combo module card is required for a Pulse Interpolation or small 
volume-type prover. 

 

For both Conventional and Pulse Interpolation, you can select the type of pipe setup: 
unidirectional or bi-directional. In a unidirectional pipe, there is no reversal of flow meter flow, 
although you may still have different sphere and valve arrangements. The 4-way valve in the 
bi-directional type of prover can reverse the direction of flow through the prover.  

Master Meter proving compares the flow through a designated and certified Master Meter against 
the flow through the custody meter to determine a correction factor. Master Meters are usually 
independently calibrated and certified by a third-party laboratory to provide a high level of 
accuracy to prove other flow meters in the field. 

 

A Meter Factor Linearization feature can be included in flow computers for liquid 
applications.  After each prove completes and the meter factor accepted, the flow 
computer automatically adjusts a meter factor curve. This feature can be applied 
regardless of the prove type. 

 

Refer to the Technical Bulletin TB-970803B Meter Factor Linearization for more 
information. This bulletin is for the OMNI 3000/6000 flow computers. You can use 
the OMNICONNECT database browser to look up the 6000 Modbus register to 
determine the corresponding 4000/7000 registers. 
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3.5.2 Prove Configuration 

To access proving configuration settings, follow these instructions: 

1.  In the Actions ribbon, click Configure.  

 

2.  a. Expand the Prover function in the 
Configure tree. 

b. Select Configuration and Setup to 
display the Prover configuration 
options in the screens on the right. 

 

3.  a. Select the Prover Type as discussed 
in Prove Types in Section 3.5.1. 

b. Click Apply. 

 

4.  a. Select the Prover Characteristics tab 
(liquid applications only), and verify or 
make changes to the settings. 

b. Click Apply. 
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5.  For Conventional-type provers, the Prover Volume/Mass screen gives you selection 
options for both Detectors on each prover, in addition to Overtravel Volume/Mass and the 
option to select which prover Volume/Mass to use during Proves (either 1 or 2).  

 

 

Before a run is repeated, the flow computer waits until the Overtravel volume or 
mass has passed through the meter. In unidirectional pipe provers, this assures that 
the sphere is back in the launch position and is ready to be re-launched for the next 
run; or, for bi-directional provers, the return trip. 

Pulse Interpolation-type provers and gas applications do not have the extended 
Volume/Mass options on this screen. 

 

6.  Select the Operational Setup tab and verify or make changes to the settings. Use the 
Meter Factor to adjust flow meter readings to show the actual volume measured during 
proving. 
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7.  In the Prove Run Setup group, adjust the 
Number of runs to average, Maximum 
number of runs and Number of passes 
per run, as needed. 

  

 

The Number of runs to average is the number of consecutive runs required that 
meet the set prove criteria to complete a prove sequence. The Maximum number 
of runs is how many times the sphere will launch to try to attempt a complete prove 
sequence. In the example displayed in Step 7, if three consecutive runs out of five 
do not meet the criteria, then the prove sequence is incomplete, or aborted. 

The Number of runs to average is only enabled for Repeatability. 

The Number of passes per run field is only enabled for Pulse Interpolation-
type provers.  

8.  In the Prove Run Setup group, adjust the 
Inactivity Timer, as needed. 

 

 

 

The Inactivity Timer entry specifies the maximum period of time, in seconds, 
allowed to elapse between the prove events. If this period is exceeded before the 
next event is expected, the flow computer aborts the prove operation, sets a "prove 
failed" flag, and prints a prove abort report. The inactivity timer is reset after the 
successful completion of each event during the prove sequence. 

9.  In the Prove Run Setup group, adjust the 
Run Acceptability settings, as needed. 

 

  

 

 

Run Repeatability between runs is calculated either by comparing raw counts or 
the calculated Meter Factor for the run, depending upon the configuration setup. 

When the required number of runs has been completed, the Meter Factor is 
calculated using either the average data method or the average Meter Factor 
method, depending upon user configuration.  

The ‘Prove in Progress’ status flag is then cleared, and the prove report is 
generated. 

Random Uncertainty complies with API MPMS CH. 4.8 and API MPMS CH. 13.1 
and is the preferred method to accept prove runs. A minimum of three runs and a 
maximum of 30 runs is required. The numerical requirement on random uncertainty 
is 0.027% at a 95% confidence level. A custom report template is required in order 
to print a prove report using Random Uncertainty. 
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10.  Adjust the settings in the Stability Check 
group, as needed.  

 

 

The flow computer checks for stability by reading the temperature and flowrate at 
the rate entered for Temperature Stability Time and compares these readings 
against the acceptable limits (Temperature Stability Limit and Flowrate Stability 
Limit). 

11.  In the Meter Factor Calculation group, 
select these options: 

• Auto implement meter factor 
immediately to automatically 
implement the new meter factor at the 
end of the prove. 

• Apply meter factor retroactively to 
retroactively apply the Meter Factor 
from the beginning of the batch. 

 

 

The Manual Implement MF Time Limit specifies the number of minutes the 
Operator has to manually accept the Meter Factor after a complete prove sequence. 
However, this timer will not be used if the Auto implement meter factor 
immediately is enabled. 

12.  In the Meter Factor Acceptability Criteria 
group, adjust the allowable average Meter 
Factor (or K-Factor) percentages, as 
needed.  

 

13.  In the Prove Reports group, select the 
options you require for your reports and 
passes.  

 

Go to Section 3.5.7 Print Prove Passes for 
more information on prove passes. 

 

14.  For instructions on the settings displayed 
on the Auto Prove Setup tab, go to 
Section  

 

Auto Prove Setup. 
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The final tab in the configuration and setup series, Prover Setup, displays 
identification information.  

 

15.  After the main Prover Configuration and 
Setup tabs are complete, continue to verify 
settings or make changes to the settings 
for the other items in the Prover tree, as 
needed. 

 

 

The items in the Prover tree can be individually selected and enabled in the 
Equipment List (Configure tree > General Setup item > Equipment List tab). 

 

Plenum Pressure Option 

For Unidirectional/Compact types of provers, you can choose to monitor the plenum pressure 
constant value. These provers use a nitrogen-pressured plenum to close the displacer poppet 
valve when the launch command is given. Insufficient or excessive plenum pressure can cause 
inaccurate prove measurements. 

The flow computer calculates the correct plenum pressure at the beginning of each prove 
sequence and charges or vents nitrogen until the measured plenum pressure is within the 
specified deadband percentage entry. The prove sequence will not continue until this pressure is 
correct. Allow sufficient time in the inactivity timer entry (see Section 0) to accommodate the time 
required to stabilize the plenum pressure. 
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To set up the plenum pressure option, follow these instructions: 

1.  In the Actions ribbon, click Configure.  

 

2.  a. Expand the Prover function in 
the Configure tree.  

b. Select Configuration and 
Setup. 

c. Verify that a Pulse Interpolation 
type prover is selected in the 
Prover Type screen. 

 

 

3.  a. Click on General Setup in the 
Configure tree. 

b. Select the Equipment List tab in 
the screens on the right. 

 

 

4.  a. In the Prover group on the lower 
right-hand side of the screen, 
check the Plenum Pressure 
option. 

b. Click Apply to save your change. 
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5.  a. Return to the Configuration and Setup screens under Prover in the Configure tree. 
b. Select the now visible Plenum Setup tab. 
c. Enter the values for Plenum Pressure Constant and Plenum Deadband %. 

 

 

6.  Select the now visible Plenum 
Pressure item in the Prover tree to 
see the configuration options. 

 

7.  a. In the Plenum Pressure screen, 
select an I/O Point (configured 
for pressure) from the drop-down 
box. 

b. Click Apply to save your change. 

 
 

8.  a. To verify the I/O selection, expand the OMNI I/O and Process I/O functions in the 
Configure tree.  

b. Select the Process Input that corresponds with the I/O Point you assigned in Step 7.  

 

Press F1 to access OMNICONNECT Help 
for a table of pressure constants and a 
formula to calculate the Plenum Pressure. 
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In this case, it is Process Input 7 in the B-1 module. Plenum Pressure is now listed 
in the Assignments on the right. 

 

 

 

For assistance viewing input channel assignments, click on Current Assignments 
in the Process I/O tree. 

 

 

 



OMNI 4000/7000 Operations and Maintenance Guide – Rev F 

 
3-25 OMNICONNECT® Operations 

 
 

Switch Bar Temperature Option 

With Pulse Interpolation and when using piston-type provers, the switch bar temperature 
accounts for the effect of expansion or contraction the temperature has on the distance between 
the optical detector switches located on the switch bar.  

In most cases, Pulse Interpolation prover detector switches are not positioned in the prover flow 
tube; they are mounted externally. The distance between the optical detector switches 
determines the prover volume. A spacing rod (also known as a switch bar or invar rod) separates 
these optical detector switches by a precise distance. Ambient temperature variations cause the 
switch bar to expand or contract, which requires adjustments to the prover water draw volume. 

To set up the switch bar temperature option, follow these instructions: 

1.  In the Actions ribbon, click Configure.  

 

2.  a. Expand the Prover function in the 
Configure tree.  

b. Select Configuration and Setup. 
c. Verify that a Pulse Interpolation type 

prover is selected in the Prover Type 
screen. 

 

 

3.  a. Click on General Setup in the 
Configure tree. 

b. Select the Equipment List tab in the 
screens on the right. 
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4.  a. In the Prover group on the lower 
right-hand side of the screen, check 
the Switch Bar Temperature option. 

b. Click Apply to save your change.  

 

5.  a. Expand the Prover function in the 
Configure tree. Now that you have 
selected the option in the Equipment 
List, “Switch Bar Temperature” now 
appears as an option in the tree. 

b. Click on Switch Bar Temperature to 
see the configuration options. 

 

6.  a. In the Switch Bar Temperature screen, select an I/O Point from the drop-down box. 
b. Enter the Alarm Limits and Override Values (optional). 
c. Click Apply to save your changes. 
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7.  a. To verify the I/O selection, expand the OMNI I/O and Process I/O functions in the 
Configure tree.  

b. Select the Process Input that corresponds with the I/O Point you assigned in Step 6.  

 

 

In this case, Process Input 6 in the B-1 module has been selected. Switch Bar 
Temperature is now listed in the Assignments on the right. 
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For assistance viewing input channel assignments, click on Current Assignments 
in the Process I/O tree. 

 

 

 

3.5.3 Prove Sequence 

A prove sequence consists of a series of command actions and observed events, such as 
Overtravel volume, the inactivity timer, run repeatability settings and checking for stability. 

For example, Table 3-1 displays the prove sequence or list of status messages received when a 
prove request is made for a unidirectional Conventional prove configured with three runs to 
average. 

 

Table 3-1: Prove Run Sequence Status Messages 

 Status Message Description 

Prove Request Checking Temp 
Stability 

Verify process variables within set parameters of 
prover configuration 

First Run 

 Launch Forward Command to start the launch 

First Detector 
Switch 

Start run counts 

In Flight Forward Status between detector switches 

Second Detector 
Switch 

End run counts 



OMNI 4000/7000 Operations and Maintenance Guide – Rev F 

 
3-29 OMNICONNECT® Operations 

 
 

 Status Message Description 

Run Complete Overtravel Forward Buffer to allow prover to ready itself for next run 

The prove sequence includes each run as configured in the prover Operational Setup tab to meet 
the required run repeatability criteria ending with a Prove Complete and acceptable Meter Factor. 
At this point you can choose to automatically or manually implement the Meter Factor. See 
Section 0 for directions on how to configure prove operations criteria. 

If there is a problem with an element of the prove configuration or any of the physical components 
involved, you may receive a prove fail or prove abort message. Table 3-2 displays a list of 
possible reasons why a prove may fail. 

Table 3-2: Prove Sequence Fail Messages 

Fail Message Description 

Prover Inactivity A prove was requested but it exceeded the configured 
Inactivity Timer before the sphere hit the first 
detector switch. 

P&M Temp Out Limit The allowable temperature deviation between meter and 
prover was exceeded. 

Bad Repeatability/Bad 
Uncertainty 

The run results exceeded the Run Repeatability or 
Random Uncertainty run acceptability criteria. 

Prover Seal Not OK The prover seal status has failed. 

Flowrate Unstable During the Stability Check, the parameters were outside 
the acceptable criteria. 

No Prover Permissive The Prove Permissive status bit was in the wrong state. 

Meter Not Active A meter active status flag was set low. 

 

 

Most ‘Prove Complete’ or ‘Prove Abort’ status flags indicating the result of a prove 
sequence are updated at the end of a prove sequence or at the time of a prove 
abort. These flags remain set until the next prove sequence is requested, at which 
time all status flags are cleared. 
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3.5.4 Auto Prove Setup 

 

The Auto Prove function is not available for Master Meter proving. 

 

The Auto Prove function selects the criteria for the flow computer to automatically execute a 
prove sequence, such as sustained changes in flow rates. A prove sequence may be executed 
after a certain amount of flow since the last prove sequence or after a set amount of flow has 
occurred after flow meter startup.  

To configure the Auto Prove function, follow these instructions: 

1.  In the Actions ribbon, click Configure.  

 

2.  a. Expand the Prover function in the 
Configure tree. 

b. Select Configuration and Setup to 
display the Prover configuration 
options in the screens on the right. 

 

3.  a. Select the Auto Prove Setup tab.  
b. Enter the necessary values to 

configure Startup time and flow, Flow 
Rate Change between Proves, and 
Maximum Flow between Proves. 

c. Click Apply to save your changes. 

 

3.5.5 Manual Prove Request 

You can access the prover in OMNICONNECT and manually request a prove at any time while 
OMNICONNECT is online with the flow computer. 

To manually request a prove, follow these instructions: 

1.  In the Actions ribbon, click Operate. 
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2.  a. Expand the Control tree. 
b. Select Prover to see the Prover 

Control screen to the right. 

 

 

 

3.  a. In the Volume/Mass Prove Control 
drop-down box, select a Meter Run.  

b. Click the Prove Request button. 
 

4.  The prove sequence begins after a prove is requested (see Section 3.5.3 Prove Sequence 
for more information). Status messages will appear in the Volume Prove Status field and 
the run information box will populate automatically. At any time, click Prove Abort to stop 
the prove sequence process while a prove is running.  

 

 

 

3.5.6 Remote Prove Request 

You can use Modbus communications to remotely trigger a prove. Write to the appropriate 
address from the following command points to execute a prove sequence: 

• 1732 – Meter 1 Prove Request  

• 1733 – Meter 2 Prove Request 
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• 1734 – Meter 3 Prove Request 

• 1735 – Meter 4 Prove Request 

• 1736 – Meter 5 Prove Request 

• 1737 – Meter 6 Prove Request 

3.5.7 Print Prove Passes 

 

The Print Prove Passes option can only be selected if the prove is a type of Pulse 
Interpolation, such as a small volume prover. 

 

To print individual, prove pass data immediately after each pass during the prove sequence, 
follow these instructions: 

1.  In the Actions ribbon, click Configure.  

 

2.  a. Expand the Prover function in the 
Configure tree. 

b. Select Configuration and Setup to 
display the Prover configuration 
options in the screens on the right. 
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3.  a. Click on the Operational Setup tab. The Prove Reports group is in the lower 
right-hand corner.  

b. Select the Print Prove Passes if it is not already checked. 
c. Click Apply to save your changes.  

 

For more information on reports, including customization, see Section 4 OMNICONNECT® 
Reports. Go to Section  

Printer Setup for instructions on how to set up your printers and select which reports to 
print. 

  

 

3.6 Batch Operations 

For liquid applications, the OMNI flow computer can track six independent flow Meter Run 
batches, each independently running any one of the 32 different configurable products in the flow 
computer. You can combine some or all of the flow meters into Stations as needed and create 
common batch stacks for the flow meters that will run the same products simultaneously. 
Batching is allowing in both gas and liquid applications, but batch stacks are used only in liquid 
applications and a maximum of two Stations is allowed. 

Flow meters using independent batch stacks can be defined as part of a Station solely for the 
purpose of sending a Station batch end command and ending all the individual Meter Run 
batches simultaneously. This action does not necessarily require the use of a Station common 
batch stack. 

For gas applications, the flow computer can also track six independent flow Meter Run batches. 
While liquid applications can have multiple products running, in gas applications a single product 
is normally tied to a flow meter and rarely changes. Therefore, the use of batch stacks is not 
required.  

All resulting batch totalizers and batch flow weighted averages can be printed, saved and reset at 
the end of each batch based on the transacted quantity, change of product or on demand. 
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3.6.1 Batch Setup and Scheduling Configuration 

To make changes to batch setup and scheduling configurations, follow these instructions: 

1.  In the Actions ribbon, click Configure.  

 

2.  Select Batch in the Configure tree. This 
opens both the Batch Setup and Batch 
Scheduling screens. 

 

 

 

3.  In the Batch Setup screen, make changes as needed to the independent Meter Runs and 
any Stations you have set up. Batch Preset Units are only available for liquid 
applications. 

Liquid: 

 

Gas: 

 

 

For Stations in liquid applications, the Batch Setup screen is where you can select 
the option to Use Common Batch Stack for that Station. It is not selected as 
a default. 
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4.  a. Click on the Batch Scheduling tab to make any changes to those options. The 
Disable Stack Shift on Auto Batch Ends option is only available for 
liquid applications. 

b. Click Apply to save your changes. 
c. For more information on batch scheduling and ending operations, go to Section 3.6.4 
d. Ending a Batch. 
e. For information on Batch Reports, go to Section 4.5.5 Batch, Daily and Prove 

Reports. 

 

3.6.2 Adjust Batch Size 

To adjust the batch size in liquid applications, follow these instructions: 

1.  In the Actions ribbon, click Operate. 

 

2.  a. Expand the Control tree, and expand 
the Batch – Stack Shift list. 

b. Select a Meter Run or Station batch 
to edit.  

 

 

 

3.  a. To adjust the size of the batch in 
progress or a currently idle batch, go 
to Step 4. 

b. To adjust the size of a batch in the 
sequence other than the batch in 
progress or one that is currently idle, 
go to Step 5. 
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4.  a. In the Batch Control screen, enter 
the adjustment amount in the Adjust 
Batch Size field. 

b. Click the Adjust Batch Size button to 
update the batch size to the amount 
you entered.  

c. Click Apply to save your changes. 

 

 

5.  For liquid applications: 

a. Click on the Batch Stack tab. 
b. Double-click on the numbered row of the batch you need to adjust to open the Edit 

Batch Stack window.  

 

6.  In the Edit Batch Stack window, enter the 
new total amount in the Batch Size field. 

   

7.  Click Apply to save your changes and 
update the size in the sequence list. 

 

 

3.6.3 Batch Stack Control 

In liquid applications, each independent flow Meter Run has a batch stack queue or sequence 
that has one active running product with five additional slots for queueing future products for 
batching. “Independent” batch stacks are useful when running different products simultaneously 
on each Meter Run. This stack configuration allows six batches to be programmed into the flow 
computer for each Meter Run.  

In applications where multiple flow meters are running the same product simultaneously, a shared 
“common” batch stack feature with one active product and 23 queue slots can be configured by 
defining a Station that includes the individual flow meters. A maximum of two Stations can be 
configured. A mix of independent and common batch stacks can be used in the flow computer. 

You can enter a positive number to 
increase the batch size or a 
negative number to decrease the 
batch size. 

Unlike the Adjust Batch Size 
option on the Batch Control 
screen (Step 3), the Batch Size 
field automatically changes the 
entire batch to match the new 
amount instead of adding or 
subtracting anything. 
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By default, the flow computer automatically sets the first product (Product 1 in the list) as the 
active product number for all batch stacks. 

To access batch stack control settings, follow these instructions: 

1.  In the Actions ribbon, click Operate. 

 

2.  Expand the Control tree to see the 
previously configured Meter Runs and 
Stations under each batch group:  

• Go to Section 3.4.1 Meter Run 
Configurations for information on how 
to make changes to Meter Runs. 

• Go to Section 3.4.2 Station 
Configurations for information on how 
to make changes to Stations. 

 

 

 

 

Two different groups of batch stacks are listed on the Control tree:  

• Stack Shift – Using this option instructs the flow computer to end the batch on 
the current running product, shift the batch stack upwards, and begin a new 
batch on the first product in the batch stack. If a new product number is not 
entered into the batch stack before ending the batch, the flow computer will not 
shift the batch stack, and it will begin a new batch measuring the same product 
as the batch that just ended. 

• No Stack Shift – Using this option instructs the flow computer to end the batch 
on the current running product and to begin a new batch measuring the same 
product as the batch that just ended. The flow computer will not shift the batch 
stack, even if there are products entered into the batch stack before ending 
the batch. 
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3.  Click on any of the Meter Runs or Stations to see their Batch Control screens. This 
screen displays an overview of the batch’s ID information, current status and totalizers.  

a. End the batch from this screen if needed by clicking the End Batch button. Go to 
Section 3.6.4 for more instructions on ending batches. 

b. Adjust the batch size from this screen if needed. Go to Section 3.6.2 Adjust Batch 
Size for more instructions on adjusting batch sizes. 

 

 

On the Batch Control screen, you can also see the batch status and type. 

 

The batch status appears as: 

• In Progress – Batch is in progress with the meter active. 

• Idle – Batch is in progress with the meter not active. 

• Batch Ended – Batch End has been received with the meter not active. 

 

The batch stack type is either Independent or Common. 

4.  Click the Batch Stack tab to see the batch stack sequence for that Meter Run or Station. 

 

5.  Double click (or right-click and select 
Edit) on any of the numbered rows to 
open the Edit Batch Stack window for 
that batch in that sequence 
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6.  Fill in the information as required and 
choose a product for that batch from the 
Product drop-down list. 

 

 

If you need to make changes to your list 
of products, go to Section 3.4.3 Products 
Configuration. 

 

7.  a. Double-click on another row to edit a 
different batch in the sequence, 
as needed. 

b. Right-click on a row to edit, insert or 
delete that batch from the sequence. 

 

8.  a. To automatically change batches in a 
sequence from one product to 
another within a single Meter Run or 
Station, assign the applicable 
products to the different batches as 
you move down the sequence. 

b. To manually end a batch and change 
the batch to a different product, go to 
Manual Batch End in Section 3.6.4 
for instructions. 

 

9.  When you are finished, click Apply to 
save your changes. 

 

 

When this stack entry becomes the 
running product, its meter factors, 
measurement selections and setup 
selections as they are currently 
configured become active. 
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3.6.4 Ending a Batch 

End a batch in progress through OMNICONNECT in one of three ways: manually through the 
Batch Control screen, automatically through a timed schedule, or remotely through Modbus 
writes. 

Manual Batch End 

To manually stop an individual batch, follow these instructions: 

1.  In the Actions ribbon, click Operate. 

 

2.  Expand the Control tree to see the 
previously configured Meter Runs and 
Stations under each batch category.  

a. For liquid applications, go to Step 3. 
b. For gas applications, go to Step 4. 

 

 

 

 

When ending a batch while flow is occurring, remember that the next batch will start 
immediately after you end the current one. 

3.  For liquid applications: 

a. To end a batch and automatically 
cause a stack shift, which 
automatically starts to measure the 
next queued product in the sequence, 
select an option in the Batch – Stack 
Shift list. 

b. To end a batch and not automatically 
shift the stack, select an option in the 
Batch – No Stack Shift list. 

c. Go to Step 5. 
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4.  For gas applications, select a Meter Run or 
Station in the Batch list. 

 

 

 

5.  In the Batch Control screen to the right, 
click the End Batch button to manually 
end your selected batch.  

 

6.  Ending a batch automatically generates a 
report. Go to Section 4.5.5 for more 
information on Batch Reports. 

 

Automatic Batch End 

To automatically end a batch on a set schedule, follow these instructions: 

1.  In the Actions ribbon, click Configure.  

 

2.  Select Batch in the Configure tree. This 
opens both the Batch Setup and Batch 
Scheduling screens. 

 

3.  a. Click on the Batch Scheduling tab to 
create a schedule for the batch 
ends—hourly, weekly, or monthly—for 
both the Meter Runs and the Stations. 

b. Click Apply to save your changes. 

 

 

The Independent Meter Runs 
options group refers to all Meter 
Runs not grouped within a Station. 
The schedule set up here applies 
to all independent Meter Runs 
associated with this flow 
computer, not to any singular 
Meter Run (such as Meter Run 1). 
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When ending a batch while flow is occurring, remember that the next batch will start 
immediately after you end the current one unless it is configured otherwise. 

For liquid applications, the Batch End Procedures options on the Batch 
Scheduling screen include the Disable Stack Shift on Auto Batch Ends selection. 
This will determine whether the flow computer will shift the batch stack upon ending 
the previous scheduled automatic batch. If it is not checked, it will shift the stack. 

 

4.  Ending a batch automatically generates a 
report. Go to Section 4.5.5 for more 
information on Batch Reports. 

 

 

Remote Batch End 

To remotely end a batch, use custom programmable statements in the flow computer or through 
Modbus-written commands from control systems.  

Batch Recalculate and Ticket Reprint 

Any one of the last 35 completed batches can be recalled from the front panel of the flow 
computer through the Batch menu by using the Recalc function key and entering a new Base 
Sediment and Water (BS&W) percentage and/or a new Reference Density/Relative Density/API 
override value before executing a batch recalculation. These new override values are usually 
obtained from a laboratory analysis report of a sample taken after the batch has ended.  

See the Modbus Database Browser in OMNICONNECT for the Modbus registers relating to batch 
recalculation through Modbus writes. 

3.6.5 Batch Preset Counters 

During the configuration of a Meter Run or Station in liquid applications, there is an option to 
activate a batch preset counter and warning flags to achieve set batch sizes.  

You can create a Batch Preset Warning through a Meter Run’s flow meter setup if it is configured 
as an Independent Batch Stack. However, if the Meter Run is part of a Station’s Common Batch 
Stack, you can only set up the warning through the Station’s configuration screen.  

Each batch preset counter is pre-loaded with the batch size taken from the appropriate batch 
stack queue. The counter is automatically decremented by the GSV flow of the Meter Run or 
Station.  
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To activate a Batch Preset Warning flag and Batch Preset Reached flag, follow these instructions: 

1.  In the Actions ribbon, click Configure.  

 

2.  a. Expand a Meter Run or Station in the tree. 
b. Select the Flowmeter item to view the Setup screen.   

 

 

 

3.  a. In the Batch Preset Warning field, 
enter the number of barrels or cubic 
meters in advance of the total batch 
size, that when reached, triggers a 
warning flag that tells the Modbus 
database that it is almost time to end 
the batch for that Meter Run or 
Station. 

b. Click Apply to save your changes.  

 

 

 

To activate the Batch Preset Counter, you must enter a batch size other than zero 
before the batch starts.  

 

The default amount in this field is 
“0.0.” A batch with the preset 
warning size of zero sets both the 
Batch Preset Warning and the 
Batch Preset Reached flags 
simultaneously when the batch 
size decrements to zero. 



OMNI 4000/7000 Operations and Maintenance Guide – Rev F 

 
3-44 OMNICONNECT® Operations 

 
 

4.  To enter a batch size, go to the Actions 
ribbon and click Operate. 

 

5.  a. Expand the Control tree. 
b. Select the same Meter Run or Station 

batch to edit that you selected in 
Step 2.  

 

 

 

6.  a. Click on the Batch Stack tab. 
b. Double-click on the numbered row of the batch you need to edit to open the Edit 

Batch Stack window.  

 

7.  a. Enter the batch size amount in the 
Batch Size field. 

b. Click Apply to update the batch size 
in the sequence list.  

 
 

 

The Batch Preset Warning and the Batch Preset Reached flags can be used in 
custom Boolean and Variable statements to end batches or control systems 
operators can monitor batches using the flags. The operators can remotely close 
valves in advance of ending batches and open valves to start batches on 
new products. 

Now that there is a number set in 
the Batch Preset Warning field 
and a fixed Batch Size, you will 
receive both the Batch Preset 
Warning and the Batch Preset 
Reached flags.  
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3.6.6 Product Interface Detection 

The flow computer can automatically detect product interfaces by monitoring the user-configured 
sustained rate of change in the specific gravity/density of a new product in the line (Figure 3-2 
and Table 3-3). For example, a custom Boolean statement can be programmed to be active 
whenever the specific gravity rate of change and the Batch Preset Reached flags are set. These 
flags can cause a 'batch end' command to be issued with custom Boolean statements or remotely 
through Modbus writes from external devices. 

 

Figure 3-2: Interface Detection Screen 

 

Table 3-3: Product Interface Detection Flags 

Interface Detection 
Flags 

Description 

Gravity/Density Rate of 
Change and Sample 
Time 

The specific gravity/density rate of change alarm flag is a flag within 
the database that is triggered whenever the rate of change of the 
gravity/density with respect to flow exceeds the preset limit for a 
sustained amount of time. It is used to detect a change in flowing 
product and is available for use in programmable Boolean 
equations and digital I/O channel functions. 

Line Pack Delay In many cases, the densitometer or gravitometer used to detect the 
product interface is mounted well in advance of the flow meter 
measuring the product or at the valve manifold. A Line Pack Delay 
flag, which is delayed by the amount of line pack Bbl (m3 or liter), 
provides an accurate indication of when the interface reaches the 
flow meter and it is time to execute a batch end command. 

 

3.7 PID Configuration  

Operators may use proportional-integral-derivative (PID) control to position valves and adjust 
pump motor speeds through the front panel, as explained in Section 6.6.6 PID Control. However, 
before output and setpoint adjustments can be made to the PID loops, the configuration and 
setup entries must be programmed into the flow computer through OMNICONNECT. 
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3.7.1 Primary and Secondary Variable Configuration 

Each PID control loop involves a primary controlled variable with override control by a secondary 
variable. The primary variable is the controlled variable unless the secondary variable exceeds or 
falls below a secondary setpoint. 

To access primary variable configuration entries, follow these instructions: 

1.  In the Actions ribbon, click Configure.  

 

2.  a. Select and expand PID Control in the Configure tree. 
b. Select PID Loop 1 to display its configuration screens to the right. 

 

 

3.  In the PID Loop 1 Config tab, enter an 
eight-character ASCII string in the Control 
Output Tag field to identify the control loop 
output. 
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4.  a. In the Primary Control Variable 
group, enter the database address of 
the primary variable in the Assign 
field.  

b. If you do not know the specific 
register number, click on the ellipses 
button to open the OMNI Database 
Browser to conduct a search.  

 

 

5.  Enter a description of the primary variable, 
up to 16 characters long, in the Remarks 
field. 

 

6.  Enter the Zero (4 mA) and Full (20 mA) 
Scale values, in engineering units, for the 
primary variable. 

  

In applications requiring flow and 
pressure control, the Assign entry 
should be a flowrate variable. For 
example, if you want the primary 
control variable to be Meter Run 1 
IV/Gross flowrate, the entry is 
7101. Set this entry to zero if you 
do not require flowrate control.  

These entries are required even if 
you do not intend to use a remote 
setpoint input for the PID 
controller. The PID algorithm uses 
these values to determine the zero 
value for the primary controlled 
variable. 
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7.  In the Primary Setpoint group, select an 
option in the Remote Input I/O drop-down 
list:  

a. Choose Unassigned if you will input 
the primary setpoint locally through 
the front panel. 

b. Choose Remote Input if you will 
provide a remote source through 
Modbus writes. 

 

8.  Enter the Minimum and Maximum 
Acceptable primary setpoint values 
(optional). 

 

 

9.  a. Repeat Steps 4 through 6 for the 
secondary control variable, if using. 

b. Enter a value for the Secondary 
Setpoint.  

 

 

10.  Click Apply to save your changes.  

3.7.2 PID Tuning Configuration 

To access PID tuning setup options, follow these instructions: 

1.  In the Actions ribbon, click Configure.  

 

When a setpoint value outside of 
this range is received, the setpoint 
will not be allowed to rise above or 
below these values. 

The primary variable will be the 
controlled variable until the 
secondary variable reaches this 
setpoint. The secondary variable 
will not be allowed to drop below 
or rise above this setpoint, 
depending on the Error Select 
entry in the PID Loop 1 Tuning 
tab. 
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2.  a. Select and expand PID Control in the Configure tree. 
b. Select PID Loop 1 to display its configuration screens to the right. 

 

 

3.  Click on the PID Loop 1 Tuning tab. 

 

4.  In the Primary group (for the primary 
control variable), select the appropriate 
Action: 

a. Choose Forward if the primary 
variable value increases as the 
controller output increases. 

b. Choose Reverse if the primary 
variable value decreases as the 
controller output increases.  

 

 

It is recommended that the action 
entry is always set to Forward. If 
necessary, select Reverse action 
when configuring the analog 
output. 
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5.  In the Response group, enter the Gain 
Factor and Repeats/Min values for the 
primary control variable. 

a. Enter a Gain Factor number between 
0.01 and 99.99. 

b. Enter a Repeats/Min value between 
0.0 and 40.00. 

 

 

The Primary Gain Factor setting determines how responsive the control will be to 
changes or upsets to the primary variable. The higher the entry, the more 
responsive the control, but a value that is too high will cause instability and 
oscillations to occur. If the setting is too low, the system will be slow to respond and 
unable to adapt to changing conditions. For flow control, an initial value of 0.75 
is reasonable. 

The Repeats per Minute entry determines the integral action of the controller. 
Integral action gradually integrates the error between the measurement and the 
setpoint, adjusting the error to zero. The larger this entry is, the faster the output will 
respond. If this entry is set too high, the system will be too responsive, and the 
controller will overshoot the setpoint, causing instability and oscillations. An initial 
value of 5 is a reasonable starting point for both primary and secondary entries. 

6.  Enter a Deadband % number. 

 

 
 

 

PID Deadband is used to minimize wear and tear on the control valve actuator in 
cases where the controlled variable is continuously changing. The control output of 
the flow computer will not change as long as the calculated PID error percentage is 
less than or equal to the entered Deadband percentage. 

7.  Select the Startup Mode: 

a. Choose Last State to keep the PID 
loop in the operating mode it was in 
before a system reset occurs. 

b. Choose Manual to start up in the 
Manual Mode with the control output 
percentage frozen to the value it was 
before the system reset. 

 

 

8.  Select the Error Select parameter: 

a. Choose Low to instruct the flow 
computer to control which variable 
(primary or secondary) has the 
“lowest calculated error percentage.” 

b. Choose High to control which variable 
has the “highest calculated error 
percentage.” 

 

This entry determines how the PID 
control will resume after a system 
reset or power-up (such as a 
momentary power loss). 
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The Error Select entry is used to determine whether the secondary variable should 
be prevented from falling below or rising above its setpoint. The control action 
selected for the primary and secondary variables also affects the setting for this 
entry (Step 4).  

This entry must be set to High Error Select in applications using only one control 
variable, as the unconfigured control variable always has a zero error. 

9.  Repeat Steps 4 and 5 for the secondary 
control variable, if using. 

 

 

The secondary Gain Factor is used to trim out response variances between the 
primary and secondary variables. For example, movements in the control valve may 
produce a larger response in pressure than in flowrate. In this case, the secondary 
Gain Factor is adjusted to a value that is less than one, ensuring a consistent 
system gain when control is automatically switching between primary and secondary 
variables. An initial value of 1.0 assumes that the primary and secondary variable 
have the same response to control valve movement. 

10.  Click Apply to save your changes.  

3.7.3 PID Ramp Control Configuration 

To minimize the possibility of equipment damage or spills resulting from rapid startups or 
shutdowns, some applications require that the flow be slowly ramped up to the setpoint and then 
ramped down. Two PID permissive flags (1722 and 1752) control the startup and shutdown ramp 
functions, and these permissives may be manipulated using Boolean statements or remotely 
through Modbus writes. 

PID Start, Shutdown and Stop command points, which are manually controlled through the front 
panel, eliminate the need to manipulate the PID permissives directly. Using these command 
points greatly simplifies operation of the PID ramping functions.  

In OMNICONNECT, you can configure the startup ramp, shutdown ramp and minimum output 
percentages. To access these setup options, follow these instructions: 

1.  In the Actions ribbon, click Configure.  
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2.  a. Select and expand PID Control in the Configure tree. 
b. Select PID Loop 1 to display its configuration screens to the right. 

 

 

3.  Click on the PID Loop 1 Ramp Control 
tab. 

 

4.  a. Enter the Startup Ramp percentage, 
or the maximum percentage that the 
control output will be allowed to 
change each 500 ms cycle. 

b. Enter the Shutdown Ramp 
percentage, or the rate at which the 
control output will ramp down toward 
0% when the first permissive is lost. 

c. Enter the Minimum Output 
percentage, or the minimum 
percentage to which the control output 
will be allowed to ramp down. 

 

 

When the stop command is 
received, the control output is 
immediately set to zero. 
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The Startup and Shutdown Ramp entries are used to specify the maximum speed 
that the valve can open or close during startup or shutdown conditions. This is 
entered as a percentage of allowed movement per half second, so an entry of 1% 
per 1/2 second would require 50 seconds to move the valve from the fully closed to 
the fully open position. Note that the ramping control has no effect during normal 
operations. 

 

For example, you can activate the PID Loop 1 start command 2013, and set the PID 
Loop 1 permissive 2001 and 2007 to “ON.” This action starts ramping the flowrate 
toward the setpoint. When the delivery is almost complete, activate the PID Loop 1 
shutdown command 2025, which resets the PID Loop 1 permissive 2001 and 
causes the flowrate to ramp down to the minimum valve open percentage. Last, 
terminate the delivery by activating PID Loop 1 Stop command 2019, resetting 2007 
and causing the valve to close completely. 

5.  Click Apply to save your changes.  

 

3.8 User Displays 

The flow computer allows up to 10 configurable user display screens, each with up to 20 Modbus 
points. These screens are configured in OMNICONNECT, and then the chosen information is 
displayed through the front panel (see Section 6.5 User Displays).  

For example, in the Meter 1 real-time user display in Figure 3-3, all 20 points are listed, but not all 
are used. The settings an Operator can fill out for each point include: 

• Register – the Modbus register of the point 

• Description – a 32-character alphanumeric description 

• Units – the engineering units of the register variable 

• Hex – an option for the value to be displayed in hexadecimal format (check for yes) 

• Exp. Notation – an option for the value to be displayed in exponential notation (check for yes) 

• Precision – an option to select the precision if the register is float or a double 
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Figure 3-3: User Display Example 

 

To access user display configurations, follow these instructions: 

1.  In the Actions ribbon, click Configure.  

 

2.  a. Select and expand the User Displays 
option in the Configure tree. 

b. Select either a previously configured 
user display to edit its settings, or a 
new user display. This example uses 
a new display, #5. 
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3.  Give the display a descriptive title in the Title field, if needed. 

 

4.  Begin to fill out the point register variables, 
as needed. In the Register column, either: 

a. Double click in the box to enter the 
register number, or 

b. Right-click and select Browser to 
open the OMNI Database Browser to 
search for the register number. 

 

 

5.  Add a brief Description. If the field is left 
blank, the description from the database is 
populated as a default. 
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6.  Choose the unit of measure from the Units 
drop-down box, as applicable. 

 

7.  If you choose to define your own units, you 
can edit 10 user-defined units.  

a. Click the Edit User Units button to 
open the User Defined Units 
window. 

b. Click within any field in the Units 
column to edit the name of the unit. 

c. Click OK when you are finished. Your 
new units will now be listed in the 
Units drop-down box in Step 6.  

 

 

8.  Continue to edit the user display screen by 
selecting the following: 

a. Hex – check for yes or leave blank for 
no (default) 

b. Exp. Notation – check for yes or 
leave blank for no (default) 

c. Precision – choose a number from 
the drop-down box (default is zero) 

 

9.  Click Apply to save your changes.   
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4. OMNICONNECT® Reports 

Most reports include a header that lists information such as the date and the time the report was 
run, the location from which the report was accessed, the firmware revision of the flow computer 
(Rev: 02.05) and the flow computer’s application mode (Liquid KF US) (Figure 4-1). 

 

Figure 4-1: Report Header Example 

 

 

By default, reports that are retrieved and saved within OMNICONNECT are 
automatically named and saved to C:\Omniflow\OmniConnect 7000\Reports. The file 
path of the reports folder and file naming conventions for these saved reports can be 
changed through the Reports tab in the Preferences window (Setup ribbon > 
Preferences button > Reports tab). 

 

  

 

4.1 Printer Setup 

4.1.1 Ethernet Printer Connection 

To print reports through an Ethernet printer connection, follow these instructions: 
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1.  In the Actions ribbon, click Configure.  

 

2.  a. Expand the Ports tree.  
b. Select and expand a Dual Ethernet 

card.  
c. Select the Ethernet ports to see the 

configuration options in the screens to 
the right. 

 

3.  Click on the Configure DE button to open 
the Ethernet Configuration window. 

 

4.  a. Click on either Printer tab.  
b. Fill in the IP address of the selected printer. 
c. Fill in other printer-specific information, as needed. 

 

5.  a. Select the Non-scheduled Reports from specific Meter Runs and Stations. 
b. Select the Scheduled and Front Panel Historical Reports from specific 

Independent Meter Runs and Stations. 
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In gas applications, Report Printer Assignments will also include the Detailed 
Daily Report.  

 

6.  In the Miscellaneous Reports group at the bottom, select any or all of the other types of 
reports you wish to print. This includes the Prove Report, Trial Report, and Prove Abort. 

 

7.  When finished selecting reports, click 
Apply to save your changes. 

 

4.1.2 Local Printer Connection 

To print reports through a local printer connection, follow these instructions: 

1.  In the Actions ribbon, click Configure.  

 

2.  Click on Local Printers in the Configure 
tree to open the printer setup option 
screens to the right. 

 

3.  Click on either Local Printer tab.  

 

4.  Select the Printer Type and enter its 
applicable Mode String. 
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5.  In the Port Assignment group, assign a 
port for Printer 1 if it is not yet assigned. 

 

6.  In the Port Options group, select an 
option from the Print Priority drop-down 
list. 

 

7.  a. Select the Non-scheduled Reports from specific Meter Runs and Stations. 
b. Select the Scheduled and Front Panel Historical Reports from specific 

Independent Meter Runs and Stations. 

 

 

In gas applications, Report Printer Assignments will also include the Detailed 
Daily Report.  

 

8.  In the Miscellaneous Reports group at the bottom, select any or all of the other types of 
reports you wish to print. This includes the Prove Report, Trial Report, and Prove Abort. 

 

9.  When finished selecting reports, click 
Apply to save your changes. 

 

10.  Repeat Steps 4 through 9 for the other 
Local Printer, as needed. 
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4.2 Report Setup 

To access the report setup options for Daily and Snapshot Reports, follow these instructions: 

1.  In the Actions ribbon, click Configure.  

 

2.  Click on the Report Setup option in the 
Configure tree to display the report setup 
screen. 

 

3.  a. Enter specific times for Daily Reports 
and Snapshot Report printing, as 
needed. 

b. Click Apply to save your changes. 
c. Go to Section 4.3 Custom Report 

Templates for instructions on Report 
Template Selection (optional). 

 

 

 

4.3 Custom Report Templates 

Customized report templates can generate custom reports instead of using the default report 
templates built into the firmware. Four reports can be customized with the use of custom report 
templates: 

• Snapshot Report 

• Batch Report 

• Daily Report 

• Prove Report 

 

 

Default report templates built into the firmware are dynamic and automatically adjust 
when the totalizer and correction factors resolution settings in the configuration are 
changed. However, custom report templates are static and will not adjust 
automatically. If the resolution configuration settings are changed, the custom report 
templates will need to be updated manually. 
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To select and edit custom report templates, follow these instructions: 

1.  In the Actions ribbon, click Configure.  

 

2.  Click on the Report Setup option in the 
Configure tree to display the report 
template settings. 

 

3.  a. In the Report Template Selection 
group, select the templates you want 
to use for each type of report. By 
default, no custom report templates 
have been imported into the flow 
computer before shipping. 

b. Click Apply to save your changes. 

 

 

 

4.  In the Actions ribbon, click Report Editor. 

 

5.  In the Report Template Editor tree, click 
on the report template you want to 
customize. 

 

Unless a template has been imported, you 
should see a blank screen in the 
Formatted View tab. 

 

 

If you choose either Template A or 
B for any of the reports, you must 
remember to import a custom 
report template to generate 
that report. 
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6.  a. If you have a previously-built template 
ready for import or if you want to see 
or use one of the sample custom 
report templates provided on your 
hard disk when OMNICONNECT was 
installed, right-click on the template in 
the Report Template Editor tree. 

b. Click Import Template. 
 

7.  a. The Import Template Window 
opens directly to the sample 
templates provided by 
OMNICONNECT. If you have a 
different template saved elsewhere, 
use this window to navigate to its 
location and select it. 

b. Select a template; then click Open. A 
customizable template is now visible 
in the Formatted View tab. 

 

 

8.  To edit a template in the Formatted View 
tab, double-click (or right-click and select 
Modify) on a highlighted segment to open 
the Modify Database Point window. 
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9.  a. Edit the settings.  
b. Click the database ICON to open the 

OMNI Database Browser, if needed. 

  

  

10.  a. When you have made your selection, 
click Select to close the OMNI 
Database Browser window. 

b. Click Modify to close the Modify 
Database Point window and update 
your changes.  

 

 

 

  

11.  a. To add new lines of code, place your 
cursor in a blank line and right-click.  

b. Select Insert. 
c. Choose which of the four types of 

code options to add.  
d. When finished editing in the 

Formatted View tab, click Apply to 
save your changes to the entire 
template.   
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The Report View tab allows you to view the report as it would look when it is 
printed. You can check the final alignment of values and make changes in the 
Formatted View or Raw View tabs, but you cannot edit the template in the Report 
View tab. 

 

12.  Click on the Raw View tab. This tab allows 
you to see Modbus field descriptions, the 
Modbus registers used to populate the 
values, each printed value’s maximum 
width and the decimal placement for each 
value.  

 
 

13.  a. Edit the template in this screen by 
placing the cursor in any position 
within the template and simply using 
your keyboard to make changes. 

b. When finished editing in the Raw 
View tab, click Apply to save your 
changes to the entire template. 

 

14.  a. Continue to import custom templates 
for the other types of reports, as 
needed. 

b. When finished, return to the Report 
Setup option in the Configure tree 
and verify that the templates you 
have imported match the templates 
you have selected in the Report 
Template Selection group (go back 
to Steps 1 through 3). 

 

 

The “$” symbol indicates that the 
Modbus register number that 
follows is where the printed value 
will be retrieved from.  
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4.4 Current Reports 

The OMNI flow computer offers access to the reports listed in Table 4-1. The naming of the 
reports can be set in Preferences under the Reports tab. 

Table 4-1: Current Reports 

Report Description File 
Extension 

Snapshot Live process variables and current totalizers .txt or .snr 

Status 
Live view of the active meters, operating batch 
stacks and active alarms 

.txt or .sts 

Product File 
List of all configured products and their Meter 
Factors 

.txt or .prd 

Site List 
Lists the flow computer communication sites 
configured in OMNICONNECT 

,txt or .site 

 

If OMNICONNECT is online, follow these instructions to access and save current reports:  

1.  In the Actions ribbon, click Operate.  

 

2.  a. In the Operate tree, expand Current 
Reports. 

b. Click on Snapshot, Status, Product 
File or Site List to view one of these 
current reports. 

 

 
 

3.  After a report is selected, OMNICONNECT 
automatically retrieves and displays the 
current report. 

 

Select one of the four options: 

a. To refresh the report, click Retrieve 
Report. 

b. To save the current report, click Save 
Report. 

c. To print the report, click Print Report 
and follow the standard printing 
prompts.  

d. To view a saved report, click View 
Saved Report and follow the 
standard opening prompts.  
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4.5 Historical Reports and Audits 

The OMNI flow computer offers access to the reports and audit trails listed in Table 4-2. The 
naming of the reports can be set in Preferences under the Reports tab. 

There are 35 of the most recent records of the Batch, Daily, Detailed Daily (Hourly), and Prove 
report type stored in the CPU memory. The remaining records are stored on the SD card, and the 
size of the SD card limits the number of stored records that can be retrieved.  

Table 4-2: Historical Reports and Audits 

Report Description File 
Extension 

Alarm 
Lists up to the last 1,000 alarm occurrences from 
the flow computer 

.txt or .alr 

Measurement Audit Trail 
Lists up to the last 1,000 measurement database 
changes  

.txt or .adt 

System Audit Trail Lists up to the last 1,000 system database changes .txt or .sat 

Last Local Snapshot 
A copy of the last requested snapshot report (from 
the front panel) of real-time conditions  

.txt or .snl 

OMNI Initialization Report 
A running list of flow computer power lost and 
power restored date/time stamps  

.txt or .init 

Batch Report Details the results of a batch end .txt or .bch 

Daily Report Details the results of a day’s end .txt or .day 

Prove Report Details the results of a prove sequence  .txt or .prv 
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If OMNICONNECT is online, follow these instructions to access and save historical reports:  

1.  In the Actions ribbon, click Operate.  

 

2.  a. In the Operate tree, expand 
Historical Reports. 

b. Click on any of the items in the list to 
view the historical report. 

 

 

 

3.  After a report is selected, OMNICONNECT 
automatically retrieves and displays the 
current report. 

 

Select one of the four options: 

a. To change the number of events to 
retrieve, select an option from the 
Record Count drop-down box and 
refresh the report by clicking Retrieve 
Report.  

b. To save the current report, click Save 
Report. 

c. To print the report, click Print Report 
and follow the standard printing 
prompts.  

d. To view a saved report, click View 
Saved Report and follow the 
standard prompts to browse for the 
report.  

 

4.  For more information on how to read or 
browse the reports, go to the following 
sections: 

a. Section 4.5.1 Alarm Reports 
b. Section 4.5.2 Measurement Audit 

Trail and System Audit Trail Reports 
c. Section 4.5.3 Last Local Snapshot 

Reports 
d. Section 4.5.4 OMNI Initialization 

Reports 
e. Section 4.5.5 Batch, Daily and Prove 

Reports 
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4.5.1 Alarm Reports 

The historical Alarm Report details up to the last 1,000 alarm occurrences from the flow computer 
(Figure 4-2). The report lists the date, time, and name (or short description) of the alarm, as well 
as the following variables: 

• Status – Whether the alarm condition is clearing (Off) or activating (On) 

• Value – The numeric value of the alarm in scientific notation 

• IV/Gross Total – A snapshot of volume totalizers at the time of the event 

• Mass Total – A snapshot of mass totalizers at the time of the event 

• Modbus – The address of the alarm (Modbus register) 

 

Figure 4-2: Historical Alarm Report Example 

4.5.2 Measurement Audit Trail and System Audit Trail Reports 

The Measurement Audit Trail Report details the last 1,000 changes to the flow measurement 
calculations and related configuration settings, where each change is a numbered event in the 
audit trail (Figure 4-3). The System Audit Trail Report details other audit events not related to flow 
measurement calculations, such as user logins. The reports list the event number, time and date 
of the event and include the following variables: 

• Modbus – The point number of the variable involved (Modbus register address) 

• Old Value/# of Points – The old value or identifier 

• New Value/Serial Port – The new value or identifier 

• IV/Gross Total* – A snapshot of volume totalizers at the time of the change 

• Mass Total* – A snapshot of mass totalizers at the time of the change 

• User Name – The user account information of the Operator or Administrator who made 
the change 

• Port – The location from which the flow computer was accessed (for example: Serial port, 
Ethernet port, front panel keyboard) 

*Measurement Audit Trail Reports only 
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Figure 4-3: Measurement Audit Trail Report Example 

4.5.3 Last Local Snapshot Reports 

The Last Local Snapshot Report is a copy of the last Snapshot Report printed locally from the 
front panel of the flow computer. It includes IV/Gross, Daily, Batch and Cumulative totals from the 
flow computer, as well as process variable live values. 

4.5.4 OMNI Initialization Reports 

The Initialization Report lists the date and time stamps of flow computer power loss and power-up 
events. 

4.5.5 Batch, Daily and Prove Reports 

Batch, Daily and Prove Reports are all similar in structure, and the user interface in 
OMNICONNECT has several filter options for browsing.  

To access and search for Batch, Daily and Prove Reports, follow these instructions: 

1.  In the Actions ribbon, click Operate.  

 

2.  a. In the Operate tree, expand 
Historical Reports. 

b. Select either Batch, Daily or Prove 
Report. 

 

 

 

 

Gas applications have a Detailed Daily Report in place of a Prove Report. 
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3.  Each report has a Record Information 
group, which shows the number of records 
the flow computer currently holds and their 
date ranges:  

a. Use the Browse Records group to 
help search for reports by such filters 
as choosing specific Meter Runs or 
Stations, number of records, and 
order of appearance. 

b. When the search filters are set, click 
Browse to update the list of records 
on the far right of the screen. 

 

 

4.  a. When you find the record you wish to 
read in the list, double-click it to 
retrieve and display the report (in text 
report format) in the view box. 

b. Save or print the report, as needed. 
 

 

 

Batch Reports include the following: 

• Meter and product identifiers 

• Start and end dates and times 

• Batch totals 

• Opening and closing cumulative 
totals 

• Batch flow weighted averages 

Daily Reports include the following: 

• Meter and product identifiers 

• Start and end dates and times 

• Daily totals 

• Daily flow weighted averages 

• All active Meter Runs and Stations 

Prove Reports include the following: 

• Prove Data – Prover and product data 

• Meter Data – Proved Meter data 

• Data from Consecutive Prove Runs – Forward and total counts, process 
variables, Meter Factors 

• Calculated Data for Prover – Prover and Meter correction factors 

• Calculated Meter Factor 

 

Detailed Daily Reports (for gas applications) include hourly data broken out on a 
daily report. 
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5. OMNICONNECT® Data Retrieval 

5.1 Dashboard 

When using OMNICONNECT and when online with the OMNI flow computer, you can view a 
summary of any Meter Run or Station through the dashboard function. 

To access the dashboard, follow these instructions: 

1.  In the Actions ribbon, click Operate.  

 

2.  In the Operate tree, click Dashboard. 

 

 

 

3.  Select any of the Meter Run or Station tabs previously configured (go to Section 3.4 
Configurations for configuration instructions) to see a summary of key information for that 
Meter Run or Station. 
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5.2 Custom Data Screens 

Custom data screens can be created for your personal use. Unlike the User Display (the 
customizable screens on the flow computer’s front panel display), these Custom Data Screens 
reside on your PC hard disk. OMNICONNECT uses the screens to retrieve and view Modbus 
registers data from any OMNI 4000/7000 flow computer you are connected to without affecting 
any configurations. 

You can create up to 10 Custom Data Screens, each with up to 10 tabs and 100 Modbus 
registers available for each tab. Therefore, the maximum number of data points that can be 
retrieved and viewed from a single flow computer is 10,000. 

 

An entire Custom Data Screen configuration or just an individual tab configuration 
can be imported or exported to your PC’s hard drive if you are using the -AU 
command line switch in the OMNICONNECT launch icon properties. Close 
OMNICONNECT; then open the icon properties and add the -AU switch at the end of 
the command line.  

To set up Custom Data Screens, follow these instructions:  

1.  In the Actions ribbon, click Operate.  

 

2.  a. Expand the Custom Data Screens 
item in the Operate tree. 

b. Expand the Setup Custom Data 
Screens item to access the setup 
options in the screens to the right. 

 

 

The screens listed under the 
Custom Data Screens item show 
what information is currently 
selected and which tabs 
are enabled.  

 



OMNI 4000/7000 Operations and Maintenance Guide – Rev F 

 
5-3 OMNICONNECT® Data Retrieval 

 
 

3.  Each of the 10 available screens has a Setup tab in addition to the 10 Meter and 
Station tabs.  

a. In the Setup tab, choose whether to enable the tree. 
b. Name the screen in the Tree Item Name field. 
c. Select which tabs to enable. 
d. Click the Apply button to save your choices. 

 

4.  a. Click on the Meter 1 tab. Each Meter or Station tab has a list of the Modbus registers 
and their descriptions that are currently being measured.  

b. Retrieval of data from all registers is enabled by default. To skip the reading of one of 
the registers, click on its check box in the Skip column.  

c. Edit or add a register or description by double-clicking in the box.  
d. Delete a register row by right-clicking the numbered cell in the far-left column and 

selecting Delete Row. 
e. If needed, also choose Precision values and a Color from the drop-down boxes. 

 

5.  Continue to edit or add Custom Data 
Screens as needed. You do not have to 
use all 10. 
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After you click the Apply button and apply any changes to any screen or tab in the 
Setup Custom Data Screens tree, the updates will automatically show as items in 
the main Custom Data Screens tree. 

 

5.3 Archives 

Archives of raw data from user-specified Modbus registers based on user-specified event flags 
are useful for collecting and archiving certain data not already automatically archived by the flow 
computer (such as hourly, batch, daily and prove). If an external polling device loses 
communication with the flow computer, the data is still archived and stored in the flow computer 
during the communications outage and is available for retrieval when communications with the 
flow computer are restored. 

5.3.1 Configure Archives 

To configure archives, follow these instructions: 

1.  In the Actions ribbon, click Configure. 

 

2.  a. Expand the Archives tree. 
b. Select the applicable archive (there 

are 25 total to configure, as needed).  
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3.  Update the fields, as applicable. 

 

There are two ways to access the 
Database Browser for the Boolean 
Trigger: 

a. Click the ellipses button, or  
b. Right-click in the Boolean Trigger 

field.  

 

 

 

 

4.  Click Apply to save your changes.  

5.3.2 Run Archives 

 

At the bottom of the Archive screen is the Archive Status. The default status for all 
archives is STOPPED, and the ability to configure them is ENABLED. To start the 
archiving feature and begin collecting the data, the configuration status must first be 
disabled. 

 

To run the archives and collect the raw data, follow these instructions: 

1.  In the Actions ribbon, click Operate. 

 

The only way to view the 
Database Browser and make 
your selection for point numbers is 
to right-click in the activated field. 
If the entire row is selected, you 
will not get the browser option.  
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2.  Select and expand the Archive 
Maintenance item in the Diagnostics 
tree. 

 

3.  a. In the Archive Configuration Status 
group on the right, click the Disable 
button to turn off the ability to make 
configuration changes to the archives. 

b. Click OK to confirm the action. 

 

4.  a. In the Archiving Status group on the 
left, click the Start button to begin 
gathering data. 

b. Click OK to confirm the action.  
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While the archiving configuration function is disabled, you cannot make changes to 
the list of data registers collected for each archive. However, you can change the 
Boolean trigger event and trigger type that causes data to be archived, if needed. 

 

5.3.3 Retrieve Archives 

 

To retrieve archive data, the Archive Status Run State must be RUNNING. If the 
Run State is STOPPED and/or the configuration is disabled, follow the instructions 
in Section 5.3.2 Run Archives to change it. 

 

To retrieve archive data, follow these instructions: 

1.  In the Actions ribbon, click Operate. 
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2.  a. Select and expand the Retrieve 
Archive Data item in the Operate 
tree. 

b. Click on the archive you want to 
retrieve. 

 

3.  Click the Retrieve button to save the data to the file location that is written at the bottom of 
the screen. The file location can be changed in your Preferences (Setup ribbon > 
Preferences button > Archives tab). 

 

4.  Click the View button to open the file and 
view the results.  
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The data recorded from all configured Modbus registers in each configured archive is 
shown as comma-separated data in the file; each record begins with the date and 
time that the group of registers were recorded.  

Data from this file can be imported for analysis into a MS Excel spreadsheet or a 
database with predefined field names that match the description of the registers 
configured in the flow computer archive. 

 

The Alarm, Measurement Audit and System Audit archive reports hold the same 
data (comma-separated) as their Historical Report counterparts when retrieved as 
formatted text reports. However, the raw data in the archives are listed from oldest to 
newest from top to bottom, while the Historical Reports are listed newest to oldest 
from top to bottom.  
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6. Front Panel Operations 

 

At various points during front panel operations you may be prompted to log in to the 
flow computer. If you do not know your password, contact your flow 
computer Administrator.  

The default Administrator password is 00 (ID) 0000 (PIN). 

 

6.1 Observing Flow 

6.1.1 Meter Runs 

To access current Meter Run flow measurements, follow these instructions: 

1.  a. In the Home menu, use the arrow 
navigation keys to go to and select 
Meter Runs. 

b. Press the OK key. 

 

 

2.  a. Use the Up or Down arrow navigation 
keys to select the Meter Run you wish 
to access. 

b. Press OK to go to the detail screen 
for that Meter Run. 

 

 

 

The yellow dots on this screen indicate that the Meter Run is not receiving a real 
signal, or it is in override or a simulated mode. The red dots indicate that an alarm 
has been triggered. 

Alternatively, you can also press 
the Mtr Runs function key along 
the bottom of the screen to access 
the same Meter Runs screen as 
shown in Step 2. 

Press the Prove function key to go 
to the Prover Control screen 
(Section 6.3 Proving Functions). 
Press the Reports function key to 
go to the Reports screen (Section 
6.4 Front Panel Reports). 
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3.  Use the Page Up or Page Down buttons 
to scroll through the Detail screen for the 
Meter Run or view the entire list of 
variables currently being measured. 

  

 

4.  Press the Totals button on the bottom left 
at any time to view the Totals screen or 
the current totalizers for the batch and 
daily values for the highlighted Meter Run.  

 

5.  To return to the Meter Runs menu and 
view a different Meter Run, either press the 
Back key until you see the screen shown 
in Step 2 or use the Right or Left arrow 
keys to select a different Meter Run at the 
top of the screen. 

 

 

  

6.  Continue to select each Meter Run to view 
its details or totals, as needed. 

 

7.  When finished, press the Home key or 
Back key to return to the Home menu, as 
needed. 

 

You can use the Right or Left 
arrow keys to switch to a different 
Meter Run from this Detail screen. 
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6.1.2 Stations 

To access current Station operations, follow these instructions: 

1.  a. In the Home menu, use the arrow 
navigation keys to go to and select 
Stations. 

b. Press the OK key. 

 

 

2.  a. Use the Left or Right arrow 
navigation keys to select the Station 
you wish to access. 

b. Press OK to go to the detail screen 
for that Station. 

 
 

3.  Use the Page Up or Page Down buttons 
to scroll through the Detail screen for the 
Station or view the entire list of variables 
currently being measured. 

 

 

4.  To return to the Stations menu and view 
Station 2, either press the Back key until 
you see the screen shown in Step 2 or use 
the Right arrow key to highlight Station 2 
at the top of the screen. 

 
 

5.  When finished, press the Home key or 
Back key to return to the Home menu, as 
needed. 

 

Alternatively, you can also press 
the Stations function key along the 
bottom of the screen to access the 
same Stations screen as shown in 
Step 2. 

Press the Reports function key to 
go to the Reports screen 
(Section 6.4). 

Station 2 is not a standard feature 
and will only appear if licensed. 
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6.2 Batch Status 

To access a snapshot of the current batch status, follow these instructions: 

1.  a. In the Home menu, use the arrow 
navigation keys to go to and select 
Batch. 

b. Press the OK key. 

 

 

2.  The Batch screen displays a simple status 
of the batches and Stations.  

 

To see the Batch Detail screen for any of 
these items, use the navigation keys to 
highlight a batch or Station in blue, and 
press OK. 

 

 

 

The Control, Stacks, Recalc and Reports function keys along the bottom of the 
Batch screen connect to their respective operations as outlined in the 
following sections: 

• Control – Section 6.6.5: Batch Control/Ending a Batch 

• Stacks – Section 6.6.5: Edit Batch Stacks 

• Recalc – Section 6.6.5: Recalculate Previous Batches 

• Reports – Section 6.4 Front Panel Reports 
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6.3 Proving Functions 

6.3.1 Manual Prove Request 

To manually request a prove, follow these instructions: 

1.  a. In the Home menu, use the arrow 
navigation keys to go to and 
select Prove. 

b. Press the OK key. 

 

2.  a. Use the Right or Left arrow keys to 
select the Meter Run (at the top of the 
screen) for which you need to run 
a prove.  

b. Press the Prove function key to start 
the prove sequence.  

 

 

3.  Press the Abort function key at any time to 
stop the prove, if needed. 

 

  

 

If a prove is active on a different Meter Run, you will see this temporary message. 

 

4.  If you need to run a prove on a different 
Meter Run, use the Right or Left arrow 
keys to select a different Meter Run at the 
top of the screen. 

 

The Status field shows the status 
of the prove as it progresses. Go to 
Section 3.5.3 for more information 
on prove status messages.  
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6.3.2 Edit Prove Transducers 

To edit proving process input variables, follow these instructions: 

1.  a. In the Home menu, use the arrow 
navigation keys to go to and 
select Prove. 

b. Press the OK key. 

 

2.  a. Use the Right or Left arrow keys to 
select the Meter Run (at the top of the 
screen) for which you need to edit the 
proving process input variables. 

b. Press the EditXdcr function key. 

 

3.  This is the Prove Transducers screen, 
which lists the editable process input 
variables for the prove. 

a. Use the Up or Down arrow keys to 
choose the process input variable you 
wish to edit. 

b. Press OK. 

 

 

4.  For the process input variables 
temperature, pressure and density, you 
can edit the Alarm Limits and 
Override values. 

a. Use the arrow keys to select the 
variable you wish to edit 

b. Press OK to access the field and 
make changes.  

c. Press OK or the Accept function key 
to save your changes. 

 

 

You can also access this screen 
directly by selecting Operate on 
the Home screen, selecting Edit 
Transducers, and using the arrow 
keys to navigate past the Meter 
Runs and Stations to the Process 
Variables (PV) screen. 
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5.  For some small volume type provers that 
have been configured to measure the 
Plenum Pressure process variable, there 
is also an option to edit the Input Zero 
Scale and Input Full Scale values. 

a. Use the arrow keys to select the 
variable you wish to edit. 

b. Press OK to access the field and 
make changes.  

c. Press OK or the Accept function key 
to save your changes. 

 

 

6.  When finished, press the Back key to 
return to the Prove Control screen to 
initiate a new prove sequence, or press it 
again to return to the Home screen. 

 

6.4 Front Panel Reports 

While all of the flow computer’s reports can be accessed through OMNICONNECT, you can also 
print reports from the front panel. 

To access and print reports, follow these instructions: 

1.  a. In the Home menu, use the arrow 
navigation keys to go to and select 
Reports. 

b. Press the OK key. 

 

Alternatively, you can access the Reports 
screen by pressing the Reports function 
key, whenever it appears, from any screen 
in the flow computer.  
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2.  a. Use the arrow keys to scroll through 
the list of reports to choose the report 
you wish to print or generate. 

b. Press OK. 

 

 

 

3.  Most of the reports listed in the Reports 
screen have no options available other 
than printing, such as the following: 

• Snapshot 

• Configuration 

• Initialization 

• Previous Snapshot 

• Product 

• Status 

 

If you select a report to print from this list, 
press the Print button on the left of the 
screen. 

 

 

 

Pressing Print will send the report to the printer(s) configured in Section 3.5.7. 

4.  The Alarm Log report requires you to 
choose a specific number of alarms, up to 
1000, to print.  

a. Press OK to access the number field 
if you wish to edit the number of 
alarms printed. 

b. Press OK or the Accept function key 
to save your changes. 

c. Press Print to print the report.  

5.  The Batch, Daily and Prove reports 
require you to choose a specific ID number 
of the desired batch, day or prove report to 
print.  

a. Press OK to access the number field 
if you wish to edit the ID number of 
the report to be printed. 

b. Press OK or the Accept function key 
to save your changes. 

c. Press Print to print the report. 
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6.  The Measurement Audit and Status 
reports require you to choose a specific 
number of events, up to 1000, to print.  

a. Press OK to access the number field 
if you wish to edit the number of 
events to be printed. 

b. Press OK or the Accept function key 
to save your changes. 

c. Press Print to print the report.  

6.5 User Displays 

The User Display option in the Home menu gives Operators the ability to view the real-time 
screens or live data produced by the flow computer (Figure 6-1). These numbered displays are 
configured through OMNICONNECT (go to Section 3.8  

User Displays). 

 

Figure 6-1: User Display Example 

6.6 Operate Features 

The Operate menu gives you the ability to edit process functions and access the batch control 
settings as well as PID control functions. 

6.6.1 Edit Meter Factor 

To edit the Meter Factor (MF), follow these instructions: 

1.  a. In the Home menu, use the arrow 
navigation keys to go to and select 
Operate. 

b. Press the OK key. 
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2.  a. In the Operate Functions menu, 
select Edit MF. 

b. Press OK. 

 

3.  a. Use the Right or Left arrow keys to 
select the Meter Run (at the top of the 
screen) for which you need to update 
the Meter Factor. 

b. When the correct Meter Run is 
selected and the Enter MF line is 
highlighted, press OK. 

 

4.  a. When the Enter MF field becomes 
active, use the number keys to enter 
the new Meter Factor. 

b. When finished, press OK or the 
Accept function key to save your 
changes. 

 

5.  Use the Right or Left arrow keys to select 
a different Meter Run at the top of the 
screen to edit other Meter Factors or press 
the Home or Back keys to return to the 
Operate Functions menu. 

 

6.6.2 Edit Density Correction Factor 

To edit the Density Correction Factor (DCF), follow these instructions: 

1.  a. In the Home menu, use the arrow 
navigation keys to go to and select 
Operate. 

b. Press the OK key. 
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2.  a. In the Operate Functions menu, 
select Edit DCF. 

b. Press OK. 

 

3.  Use the Right or Left arrow keys to select 
the Meter Run or Station (at the top of the 
screen) for which you need to update 
the DCF. 

 

 

 

 

If the densitometer was not configured for a Station in OMNICONNECT, you will see 
this message. 

 

4.  a. When the correct Meter Run or 
Station is selected, use the Up or 
Down arrow keys to choose either the 
Enter DCF A or Enter DCF B line to 
edit. 

b. Press OK. 

 

5.  a. When the Enter DCF A/B field 
becomes active, use the number keys 
to enter the new DCF. 

b. When finished, press OK or the 
Accept function key to save your 
changes. 
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6.  Use the Right or Left arrow keys to select 
a different Meter Run or Station (at the top 
of the screen) to edit other DCFs or press 
the Home or Back keys to return to the 
Operate Functions menu. 

 

6.6.3 Edit Products 

To edit products, follow these instructions: 

1.  a. In the Home menu, use the arrow 
navigation keys to go to and select 
Operate. 

b. Press the OK key. 

 

2.  a. In the Operate Functions menu, 
select Edit Products. 

b. Press OK. 

 

3.  a. Use the arrow keys and page buttons 
to navigate to the product you wish to 
edit. 

b. When the correct product is 
highlighted, press OK. 

 

4.  This is the Product # Operate screen.  

a. If you need to edit the product’s Meter 
Factor, go to Step 5. 

b. If you need to edit the product’s DCF, 
go to Step 6.  
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5.  a. If you need to edit the product’s Meter 
Factor, select Edit MF. 

b. Press OK.  
c. Go to Section 6.6.1 Edit Meter Factor, 

and follow the instructions in Steps 3-
5 to edit the Meter Factor.  

d. When finished, press the Back key to 
come back to this screen; then 
continue from here to Step 6 to edit 
the DCF. 

 

6.  a. If you need to edit the product’s DCF, 
select Edit DCF. 

b. Press OK. 

 

7.  If the product is configured in 
OMNICONNECT to use the Product DCF, 
you can edit it for any Meter Run or Station 
from this screen using the arrow and 
number keys.  

a. Press OK to access the number field 
and enter your changes.  

b. When finished, press OK or the 
Accept function key to save your 
changes 

 

 

If the product is configured to use the Meter Run or the Station’s DCF (A or B), you 
will see this screen. 

 

8.  a. Press the Back key to come back to 
the Product # Operate screen. 

b. Select Edit API/Rel Density to edit 
the DCF selection or relative density 
values. If you have a Metric firmware 
application, select Edit Ref Density.  
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9.  a. Use the arrow keys to select the line 
you wish to edit and then press OK to 
access the field and make changes.  

b. When finished, press OK or the 
Accept function key to save your 
changes. 

 

 

 

 

10.  Press the Back key to return to the main 
Products screen and select the next 
product to edit, as needed. 

 

6.6.4 Edit Transducers 

To edit transducer settings, follow these instructions: 

1.  a. In the Home menu, use the arrow 
navigation keys to go to and select 
Operate. 

b. Press the OK key. 

 

2.  a. In the Operate Functions menu, 
select Edit Transducers. 

b. Press OK. 

 

While you can only edit the product 
name from OMNICONNECT, you 
can edit both the DCF Selection 
(A, B or Product) and the Relative 
Density value from this screen. 
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3.  Use the Right or Left arrow keys to select 
the Meter Run or Station (at the top of the 
screen) for which you need to update the 
process variables. 

 

 

 

 

If these process variables were not configured for a Station in OMNICONNECT, you 
will see this message. 

 

4.  a. When the correct Meter Run or 
Station is selected, use the Up or 
Down arrow keys to choose the 
process variable you wish to edit. 

b. Press OK. 

 

5.  a. Use the arrow keys to select the 
variable you wish to edit. 

b. Press OK to access the field and 
make changes.  

c. Press OK or the Accept function key 
to save your changes.  

  

  

 

Depending on the I/O type assigned to the transducer (Temperature, Pressure, etc.), 
you may see different items listed on this screen. 
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6.  a. Press the Back key to return to the 
main Transducers menu. 

b. Use the navigation keys to select a 
different Meter Run or Station to edit, 
as needed. 

 

7.  If the flow computer is configured through 
OMNICONNECT to use Auxiliary Inputs, 
you can also access and edit their process 
variables through the Transducers 
screen. 

 
 

 

6.6.5 Batch Operations 

To access batch operations from the front panel, follow these instructions: 

1.  a. In the Home menu, use the arrow 
navigation keys to go to and select 
Operate. 

b. Press the OK key. 

 

2.  In the Operate Functions screen, select 
Batch. 

 

Auxiliary Inputs can be used to 
bring in signals for variables such 
as %BS&W and viscosity. 
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3.  a. Use the arrow keys to select one of 
the following operations: 

• Batch Control  

(go to Section 6.6.5: Batch 

Control/Ending a Batch) 

• Edit Batch Stacks  

(go to Section 6.6.5: Edit Batch 

Stacks) 

• Recalc Prev Batch  

(go to Section 6.6.5: Recalculate 

Previous Batches) 

b. Press OK. 

 

Batch Control/Ending a Batch 

To access batch control operations, follow these instructions: 

1.  a. From the Batch Operations screen, 
select Batch Control. 

b. Press OK. 

 

2.  To view a current batch, use the Right or 
Left arrow keys to select a Meter Run or 
Station (at the top of the screen) currently 
running a batch. 

 

3.  Use the Up or Down arrow keys to scroll 
through the list of details for that batch. 
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4.  You can edit some of the variables for any 
of the batches currently configured, such 
as Batch ID Number, Adjust Batch Size, 
Batch Remaining and any of the Batch 
Total values.  

a. Use the arrow keys to select the 
variable you wish to edit. 

b. Press OK to access the field and 
make changes.  

c. Press OK or the Accept function key 
to save your changes. 

 

5.  Use the Right or Left arrow keys to select 
a different Meter Run or Station (at the top 
of the screen) to view or edit its batch 
operations. 

 

 

If a Station is running a common batch stack, it will be listed on its Batch Control 
screen (left). The Meter Runs defined as part of a Station and using a common batch 
stack will display a notice (right) rather than displaying individual Meter Run batch 
details as it would for a Meter using an Independent batch stack. 

  

6.  To end a selected batch and generate a 
report, either press the End+Shift function 
key or the End function key. 

 

 The End+Shift function key ends 
the current batch, but it allows the 
next batch in the sequence to 
start on the next product in the 
batch stack queue. The End 
function key ends the current 
batch and starts a new batch with 
the same product as was running 
before, not allowing a batch stack 
to shift to the next product in 
the queue. 
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7.  a. Continue to view, edit or end batches, 
as needed.  

b. When finished, press the Back key to 
return to the Batch Operations 
screen or the Home key to return to 
the Home screen. 

 

Edit Batch Stacks 

To edit batch stacks, follow these instructions: 

1.  a. From the Batch Operation screen, 
select Edit Batch Stack. 

b. Press OK. 

 

2.  To view a current batch stack, use the 
Right or Left arrow keys to select a Meter 
Run or Station (at the top of the screen) 
running a batch. 

 

3.  Use the Up or Down arrow keys to scroll 
through the list of details for that batch 
stack and all the batches in its sequence. 

 

4.  You can edit some of the variables for any 
of the batches currently configured, such 
as Batch ID Number, Batch Size and 
Product Number.  

a. Use the arrow keys to select the 
variable you wish to edit. 

b. Press OK to access the field and 
make changes.  

c. Press OK or the Accept function key 
to save your changes. 
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If a Station is running a Common Batch Stack, it will be listed on its Batch Control 
screen (left). The Meter Runs assigned to this stack will display a notice (right) rather 
than any batch details (as it would for an Independent Batch). 

  

If a stack is not configured in OMNICONNECT, the flow computer will display 
a notice. 

 

5.  a. Continue to view or edit batch stacks, 
as needed.  

b. When finished, press the Back key to 
return to the Batch Operations 
screen or the Home key to return to 
the Home screen. 

 

Recalculate Previous Batches 

Previous batches may need to be recalculated based on updated volume correction data, such as 
%BS&W or reference gravity/density, which is usually determined by laboratory analysis. 

To access previous batch records and recalculate them, follow these instructions:  

1.  a. From the Batch Operation screen, 
select Recalc Prev Batch. 

b. Press OK. 
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2.  Use the Right or Left arrow keys to select 
a Meter Run or Station (at the top of the 
screen) to access the batch records for 
each. 

 

3.  After selecting the Meter Run or Station, 
press the Search button on the left to view 
the list of previous batch records. 

 

4.  a. In the Batch Record Browser, use 
the Up or Down arrow keys to scroll 
through the list of records for that 
Meter Run or Station. 

b. Select the batch you wish to 
recalculate. 

c. Press OK. 

 

 

5.  a. Use the arrow keys to select the 
variable you wish to edit. 

b. Press OK to access the field and 
make changes.  

c. Press OK or the Accept function key 
to save your changes. 

 

You can search for a batch by the 
time and date it was run or by its 
number in the left-hand column, 
which is also accessible in the 
Historical Batch Reports through 
OMNICONNECT. 



OMNI 4000/7000 Operations and Maintenance Guide – Rev F 

 
6-22 Front Panel Operations 

 
 

6.  When finished entering your changes, 
press the Execute function key to 
recalculate the batch and generate a 
report. 

 

 

7.  Continue to recalculate batches as needed 
by selecting the Meter Run or Station and 
searching for the batch. 

 

6.6.6 PID Control  

 

PID control functions are accessible through the front panel through Modbus writes. 
You can also manage a limited number of PID settings through the front panel, but to 
fully configure PID functions, go to Section 3.7  

PID Configuration to complete PID setup in OMNICONNECT. 

PID control gives you the ability to vary output to a control valve based on process variable 
readings using independent control loops (see Section 3.7 for setup) (Figure 6-2). Each of the six 
available loops can control a primary variable setpoint (usually flow rate) with a secondary 
variable setpoint (usually meter back pressure or delivery pressure). 

The primary and secondary setpoints can be adjusted locally through the front panel and 
remotely through a communication link. The primary setpoint can also be adjusted through an 
analog input to the flow computer. 

Operators can use contact closures to initiate the startup and shutdown ramp function, which 
limits the control output slew rate during startup and shutdown conditions. 

A high or low 'error select' function causes automatic override control by the secondary variable 
when it is necessary either to maintain a minimum secondary process value or limit the 
secondary process maximum value. 

If a printer is connected and the 
flow computer is configured to 
print batch reports to it, the 
recalculated batch report will 
automatically print. You can also 
manually print reports from the 
front panel (Section 6.4) or access 
them through OMNICONNECT 
(Section 4). 
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Figure 6-2: Typical PID Control Application (Single Loop) 

 

To access PID control functions, follow these instructions: 

1.  a. In the Home menu, use the arrow 
navigation keys to go to and select 
Operate. 

b. Press the OK key. 

 

2.  a. In the Operate Functions menu, 
select PID. 

b. Press OK. 

 



OMNI 4000/7000 Operations and Maintenance Guide – Rev F 

 
6-24 Front Panel Operations 

 
 

3.  Use the right or left arrow keys to view the 
settings for each loop. 

 

 

Key PID control settings include: 

• Control Type – Indicates which parameter is being controlled: primary or 
secondary 

• Primary/Secondary Measured – Shows the actual measurement value of the 
primary or secondary parameter in engineering units 

• Primary/Secondary Setpoint – Shows the actual primary or secondary setpoint 
currently used in engineering units 

• Primary Setpoint Source – Indicates whether the source of the primary input is 
remote or local 

• Remote Setpoint Value – Shows the current value of the remote setpoint in 
engineering units 

4.  To edit the control settings, go to the 
following sections in Section 6.6.6 for PID 
operations information and instructions: 

• Change PID Operating Mode. 

• Local and Remote Setpoints  

• Startup and Shutdown Ramping 
Functions. 

• PID Control Tuning. 

 

Change PID Operating Mode 

While the default PID control operating mode is automatic, the flow computer incorporates local 
manual control of the control output through the front panel and a bumpless transfer between 
automatic and manual control. 

To change the PID control operating mode from automatic to manual (and back), follow these 
instructions: 

1.  In the PID Control screen for your 
selected loop, press the Override function 
key on the bottom left. 
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2.  a. With Manual Valve? highlighted, 
press the OK key to open the option 
field.  

b. Scroll down to select Yes, and press 
OK again. 

 

 

 

Even if the Local Setpoint is set to Yes on this screen, you are still in Automatic 
Mode if the Manual Value? is set to No. The Manual Value? must be set to Yes to 
enter Manual Mode. 

3.  You are now in Manual Control. 

a. Scroll down to highlight Manual 
Valve % and press OK. 

b. Adjust the percentage that the valve is 
left open, as needed. 

c. When finished, press OK.  

 

4.  To return to Automatic Control, highlight 
and select Manual Valve? again, and 
select No. 

 

 

Local and Remote Setpoints 

The PID control loop can be configured to accept either a Local Setpoint or a Remote Setpoint 
value for the Primary Controlled variable. The Remote Setpoint is derived from a Modbus write or 
an analog input (usually 4–20 mA). This input is scaled in engineering units. 

 

You must configure both zero (4mA) and Full Scale (20mA) values. The 4‒20 mA 
scaling of this input determines the scaling of the controlled variables. 
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To switch from a Remote to a Local Setpoint (and back), follow these instructions: 

1.  In the PID Control screen for your 
selected loop, press the Override function 
key on the bottom left. 

 

2.  a. Use the arrow keys to scroll down and 
highlight Local Setpoint?.  

b. Press OK to open the option field, and 
select Yes.  

c. Press OK. 

 

 

 

3.  a. Scroll down to Local Setpoint and 
press OK. 

b. Enter the new Local Setpoint value. 
c. Press OK. 

  

4.  To return to a Remote Setpoint, highlight 
and select Local Setpoint? again, and 
select No. 

 

  

You can change from a Remote 
Setpoint to a Local Setpoint 
while in either Automatic or 
Manual Mode. The switch from 
Remote to Local is bumpless. 

Setting a Secondary Setpoint 
value is optional. 

The switch to the Remote Setpoint 
may not be bumpless, depending 
upon the Remote Setpoint source. 



OMNI 4000/7000 Operations and Maintenance Guide – Rev F 

 
6-27 Front Panel Operations 

 
 

Startup and Shutdown Ramping 
Functions 

Startup and shutdown ramping functions are enabled when a startup and/or shutdown ramp rate 
between 0 and 99% is entered during PID configuration (Section 3.7). 

On the bottom of the main PID Control screen (Figure 6-3), there are three command function 
keys (besides Override, as discussed in Local and Remote Setpoints): 

• Start – Begin the process of the valve ramping open (start the batch). 

• RampDown – Begin the process of the valve ramping down to the minimum percent open. 

• Stop – Immediately close the valve after it has been ramped to the minimum percent open 
and stop the flow. 

 

Figure 6-3: PID Control Screen 

Inputs are provided for startup and shutdown ramp rates and minimum output percentage 
settings. When these startup and shutdown ramp rates are applied to the control output, 
movements will be limited to the stated percentage of movement per half-second. On receipt of a 
shutdown signal (the RampDown function key), the output will ramp to the minimum output 
percentage for top off purposes. 

PID Control Tuning 

Individual control of gain and integral action are provided for both the primary and secondary 
control loops.  

To tune PID loops, follow these instructions: 

1.  In the PID Control screen for your 
selected loop, press the Override function 
key on the bottom left to enter the Manual 
Override screen. 
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2.  Tune the primary variable loop first: 

a. Use the arrow keys to scroll down and 
highlight Secondary Setpoint.  

b. Press OK. 
c. Enter the new Secondary 

Setpoint value. 
d. Press OK again to save the entry. 

 

 

3.  Press the Return button to go back to the 
PID Control screen. 

 

4.  a. Use the arrow navigation keys to 
scroll down and highlight 
Primary Gain. 

b. Press OK. 
c. Enter the new value. 
d. Press OK again to save the entry. 

 

 

5.  Press the Override function key again to 
return to the Manual Override screen.  

 

6.  a. Use the arrow navigation keys to 
scroll down and highlight 
Secondary Setpoint. 

b. Press OK. 
c. Temporarily adjust the Secondary 

Setpoint to allow control on the 
secondary variable without 
interference from the primary variable.  

d. Press OK again to save the entry.  

7.  Press the Return button to go back to the 
PID Control screen. 

 

Set the Secondary Setpoint high 
or low enough to stop the 
secondary control loop from 
taking control. 

Adjust the primary gain and integral 
repeats per minute for 
stable control. 
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8.  a. Use the arrow navigation keys to 
scroll down and highlight 
Secondary Gain. 

b. Press OK. 
c. Adjust the Secondary Gain and 

integral repeats per minute for stable 
control of the secondary variable. 

d. Press OK again to save the entry. 

 

9.  Press the Override function key again to 
return to the Manual Override screen. 

 

10.  a. Use the arrow navigation keys to 
scroll down and highlight 
Secondary Setpoint. 

b. Press OK. 
c. Return the Secondary Setpoint to 

the original value so that the primary 
variable will be controlled again. 

d. Press OK again to save the entry. 
 

Estimate PID Loop Gain 

Each process loop will exhibit a gain function. A change in control valve output will produce a 
corresponding change in each of the process variables. The ratio of these changes represents 
the gain of the loop. For example, if a 10% change in control output causes a 10% change in the 
process variable, the loop gain is 1.0. If a 10% change in control output causes a 20% change in 
process variable, the loop gain is 2.0.  

To provide stable control, the gain of each loop with the controller included must be less than 1.0. 
In practice, the controller gain is usually adjusted so that the total loop gain is between 0.6 and 
0.9. Unfortunately, the gain of each loop can vary with operating conditions. For example, a 
butterfly control valve may have a higher gain when almost closed, than when it is almost fully 
open. This means that in many cases, the controller gain must be set low so that stable control is 
achieved over the required range of control. 

To estimate the gain of each loop for the required range of operating conditions, follow 
these instructions: 

1.  Go to the Change PID Operating Mode in 
Section 6.6.6 and place the PID operating 
mode into Manual Mode. 

 

When finished, continue to Step 2. 

 

2.  While in Manual Mode, use the arrow 
navigation keys to scroll down and 
highlight Manual Value %. 

  

Adjust the control output for the 
required flow conditions and note 
the process variable values. 



OMNI 4000/7000 Operations and Maintenance Guide – Rev F 

 
6-30 Front Panel Operations 

 
 

3.  a. Press OK to open the field for editing. 
b. Make a known percentage step 

change of output. 
c. Press OK again to save the entry. 

 

For example, from 20% to 22% equals a 
10% change. 

 

 

Note the percentage change of each process variable: 

• Primary Gain Estimate = 0.75 (Primary Loop Gain) 

• Secondary Gain = 0.75 (Secondary Loop Gain Estimate) 

 

For example, 100 m3/hr to 110 m3/hr equals a 10% change in flow rate. 

Estimate PID Repeats and Minutes 

To estimate the repeats and minutes and fine-tune the gain, follow these instructions: 

1.  a. In the PID Control screen, use the 
arrow navigation keys to scroll down 
and highlight Pri Rpts/Min. 

b. Press OK. 
c. Enter 40 as the new primary variable. 
d. Press OK to save your changes. 

 

2.  a. Scroll down and highlight 
Sec Rpts/Min. 

b. Press OK. 
c. Enter 40 as the new 

secondary variable. 
d. Press OK again to save the entry. 

 

3.  Press the Override function key on the 
bottom left to enter the Manual Override 
screen. 

 

4.  Adjust the setpoints so that only the 
primary variable is in control. 

 

Go back to PID Control Tuning in Section 
6.6.6 for instructions.  When finished, 
continue to Step 5. 

 

5.  Press the Return button to go back to the 
PID Control screen. 
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6.  a. Use the arrow navigation keys to 
scroll down and highlight 
Primary Gain. 

b. Press OK. 
c. While controlling the primary variable 

(Step 4), increase the primary gain 
until some controlled oscillation is 
observed. 

d. Press OK again to save the entry.  

7.  a. Scroll to and highlight Pri Rpts/Min 
and press OK. 

b. Set the Pri Rpts/Min to equal 0.75 
(period of the oscillation in minutes). 

c. Press OK. 

 

8.  a. Scroll to and highlight Primary Gain 
again and press OK. 

b. Set the Primary Gain to 75% of the 
value needed to make the 
loop oscillate. 

 

9.  Repeat Steps 3 to 9 for the 
secondary variable. 

 

6.6.7 Other Operations 

Force Day End 

The Force Day End operation is accessible through the Operate Functions screen (Home menu > 
Operate). You may manually force the end of operations for the day and immediately start a new 
day for any given Meter Run or Station and generate a Daily report. 

User Prompts 

The User Prompts operation is accessible through the Operate Functions screen (Home menu > 
Operate). You may view the list of up to 16 user prompts previously configured in 
OMNICONNECT. 

Archive Maintenance 

The Archive Maintenance operation is accessible through the Operate Functions screen (Home 
menu > Operate). You may view the archive status and disable or enable the configuration to 
allocate memory for data to be archived through OMNICONNECT, but you cannot edit any 
archive details through this screen. 
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Leak Detection 

The Leak Detection operation is accessible through the Operate Functions screen (Home menu > 
Operate). You may manually command the flow computer to capture the current totalizer values 
at the time a leak is detected. The Leak Detection command can also be issued through a 
Modbus write. 

6.7 Firmware 

The Firmware screen, which is accessible through the Home menu, allows Operators to see a list 
of firmware features on the flow computer with their current revision numbers and checksums 
(Figure 6-4). These include the following features: 

• Main firmware application revision 

• CPU serial number 

• Dual Ethernet firmware revisions 

• Configuration and metrological checksums 

 

Figure 6-4: Firmware Revisions/Checksums Screen 
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7. Maintenance 

7.1 Software and Firmware Updates 

 

See Section 4.7.3 Setup Preferences and Section 4.9 Check for Updates in the 
Installation Guide to set preferences for firmware and software updates as well as 
instructions on how to manually check for new version releases. 

7.2 OMNICONNECT® Diagnostics 

7.2.1 I/O Overview 

The I/O Overview function allows you to view the flow computer’s diagnostics information and 
system overview through OMNICONNECT. It also has the related Digital MUX screen, which 
shows digital input and output points for the system and can indicate whether there is a problem 
with any of the fuses.  

To view this information, follow these instructions: 

1.  In the Actions ribbon, click Diagnostics. 

 

2.  Select and expand I/O Overview in the Diagnostics tree. This opens the I/O Overview 
screen, which displays a live view of the flow computer’s general signals. 
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3.  Click on the Remote Inputs tab to view a 
list of live remote inputs coming from the 
flow computer. 

 

4.  Click on DM in the Diagnostics tree. This 
opens the Digital MUX screen, which 
shows the digital I/O points for the modules 
that are present in the system. 

 

 

 

 

 

If an electronic fuse on the DM module has tripped, you should verify that the wiring 
is correct between the external device and the flow computer (as depicted by your 
installation drawings). If the wiring is correct, there may be a problem with the 
external device. 

 

7.2.2 Calibration 

To calibrate an analog input channel, follow these instructions: 

The Calibration menu can be accessed through the Diagnostics button on the Home ribbon. If 
there is a project-specific requirement to reset all input and output channels before calibration, 
perform the steps in the applicable Reset Single Channel Calibration or Reset Multiple Channel 
Calibration instructions in Section 7.2.5 System Resets before calibrating.  

The LED status indicators show 
green (ON), gray (OFF or not in 
use) or red when the fuse is 
tripped. The far-right column 
displays either “Fuse OK” or 
“Fuse Tripped.”  
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For inputs and outputs: 

• Click the Restore button any time after starting a calibration. This command 
restores the calibration constants to the values they were when the calibration 
was initiated. 

• Click the Apply Defaults button any time after starting a calibration to: 

− Reset the calibration constants to their default non-calibrated values.  

− Clear the adjustments for a selected channel. 

Analog Inputs 

To calibrate analog input channels that are configured in the flow computer, follow these 
instructions: 

1.  Click the Diagnostics button in the Home 
ribbon to open the Diagnostics tree in the 
left panel. 

 

 
 

2.  Click Calibration in the left panel to 
display its configuration settings in the 
screens on the right. 

 

3.  Select the Analog Inputs tab.  

 

4.  Select the input channel to calibrate from the drop-down list.  

 

To include input channels in the drop-down list that were not assigned during 
configuration, check the Include Unassigned I/O box.  

 

 

For a selected input channel with an active signal connected, the flow computer 
recognizes the live value and displays it in the Live Value field. 

If an I/O is assigned, the live value is displayed in engineering units. 
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5.  Verify that the signal wiring on the back 
panel is correct.  

 

6.  a. Click Start Calibration. 

b. Click Yes to confirm on the pop-up 
window.  

 

 

 

If the Remark field is not filled in during the Analog input channel configuration, then 
the Modbus register’s database description, the hardware module and the Terminal 
Block pin numbers are still displayed in blue text after a selection is made. If the input 
channel is unassigned, only the hardware module and Terminal Block pin numbers 
are still displayed in blue text. 

7.  If you are calibrating an input that has 
been assigned, the Set Override group 
will appear and you will be able to enter 
the override value:  

a. Verify or edit the default value and 
then click Apply Override. 

b. Go to to Step 10. 

 

If you are calibrating an input that has not 
been assigned, only the Calibration Units 
group will appear (it will skip the Set 
Override group). Continue to Step 8. 

 

 

 

8.  Select the type of signal (for which the 
channel has been configured with the 
hardware jumpers) and click Apply Units. 

 

 

This action records the following 
information in the Measurement 
Audit Trail Log: 

• Time, date and I/O index 

• Input # ‘n’ calibration start 
(n = input channel number) 

• User name, user ID and port 
used for the calibration 

The unit options are: 

• mA  

• Volts 

• Ohms (if the channel has 
been configured for an RTD 
type signal) 

• Engineering units (if an I/O 
channel is assigned)) 
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9.  Click Calibrate Input.  

 

Click Abort to abort the current calibration 
sequence. 

 

10.  To apply the low calibration value in the 
Calibration Values screen: 

a. Adjust the Signal Generator or 
configure the Transmitter, whichever 
is connected, to output the lowest 
value needed to calibrate. 

b. Wait 20 to 30 seconds for the 
readings to stabilize. 

c. Enter an equivalent value in the 
appropriate units into the Low 
Calibration Value field 
(for example, 4 mA or 0.000 °F). 

d. Click Apply Low. 

 

 

11.  To apply the high calibration value in the 
Calibration Values screen: 

a. Adjust the Signal Generator or 
configure the Transmitter to output 
the highest value needed for 
calibration. 

b. Wait 20 to 30 seconds for the 
readings to stabilize. 

c. Enter an equivalent value in the 
appropriate units into the High 
Calibration Value 
(for example, 20 mA or 0.000 °F).  

d. Click Apply High. 

 

 

12.  To stop calibration, disconnect any signal 
simulators that are being used to calibrate 
the input channel, and reconnect the field 
instrument wiring according to your 
project-specific diagrams.  

 

Low values are 4.00 mA for a 4‒20 
mA input, 1 V for a 1‒5 V input, and 
25 ohms for an RTD input. 

High values must be stated for 
each type of input: 20.00 mA for a 
4‒20 mA input, 5 V for a 1‒5 V 
input, and 150 ohms for an 
RTD input. 
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13.  Click End Calibration to complete the 
calibration of the input channel. The 
calibration constants will be saved. 

 

Click Cancel at any time to end the 
calibration without saving the calibration 
constants. 

 

14.  Continue calibrating additional analog 
inputs by repeating Steps 1 through 13. 

 

15.  If you have trouble calibrating the input 
channel, reset the channel and attempt to 
calibrate the channel again.  

• For troubleshooting a single input 
channel, go to Reset Single Channel 
Calibration in Section 7.2.5. 

• For troubleshooting multiple input 
channels, go to Reset Multiple 
Channel Calibration in Section 7.2.5. 

 

Analog Outputs 

To calibrate analog output channels that are configured in the flow computer, follow these 
instructions: 

1.  On the Calibrations screen, select the 
Analog Outputs tab.  

 

Select the 4‒20 mA output channel to 
calibrate from the drop-down list.  

 

To include output channels in the 
drop-down list that have not been 
assigned in the configuration, check the 
Include Unassigned I/O box.  

  

2.  If the channel has been assigned in the 
configuration, confirm that the Modbus 
Register Assignment, Remark and 
Values at 4 mA and 20 mA are displayed 
in blue text.  

 

  

 

If the Remarks field is not filled in during the Analog output channel configuration, then 
the Modbus register’s database description, the hardware module and the Terminal Block 
pin numbers are still displayed in blue text after a selection is made. If the output channel 
is unassigned, only the hardware module and Terminal Block pin numbers are still 
displayed in blue text. 
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3.  Connect an ammeter to the Terminal 
Block output pins in series between the 
flow computer and the external 4‒20 mA 
device. 

 

4.  Click Start Calibration.  

 

 

5.  If needed, enter a value in milliamps in 
the Analog Output Value field, and click 
Apply Value.  

 

The flow computer will output the value 
using the current calibration constants. 

 

6.  Click Calibrate Output. If needed, click 
Abort to abort the current calibration 
sequence. 

 

The flow computer is instructed to 
output 4 mA. 

 

7.  Wait 20 to 30 seconds for the readings to 
stabilize. 

 

8.  Enter the value displayed on the 
ammeter; then click Accept Low.  

 

If the low value is accepted, the flow 
computer is instructed to output 20 mA.   

9.  Wait 20 to 30 seconds for the readings to 
stabilize. 

 

10.  Enter the value displayed on the 
ammeter; then click Accept High. 

 

This action records the following 
information in the Measurement 
Audit Trail Log: 

• Time, date and output index 

• Output # ‘n’ calibration start 
(n = output channel number) 

• User name, user ID and port 
hosting the calibration 
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11.  Click End Calibration to complete the 
calibration and save the calibration 
constants. 

 

Click Cancel at any time to end the 
calibration without saving the calibration 
constants. 

 

12.  Continue calibrating additional analog 
outputs as needed by repeating 
this section. 

 

13.  If you have trouble calibrating the output 
channel, reset the channel and attempt 
to calibrate the channel again.  

 

• For troubleshooting a single output 
channel, go to Reset Single Channel 
Calibration in Section 7.2.5. 

• For troubleshooting multiple output 
channels, go to Reset Multiple 
Channel Calibration in Section 7.2.5 

 

7.2.3 Calibration Verification 

Analog Input Verification 

To verify that the input calibration variables are correct or within the acceptable error tolerance 
and so do not require calibration, follow these instructions: 

1.  In the Actions ribbon, click Diagnostics. 

 

 

 

2.  Click on Calibration Verification in the 
Diagnostics tree. 
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3.  Select an analog input calibration to verify 
by following the instructions in Steps 3 
through 8 in the Analog Inputs section in 
Section 7.2.2 Calibration. 

 

After you apply your chosen Calibration 
Units, the Verify Input group will appear.  

 

4.  a. Enter the Applied Value from the 
calibration verification 
instrumentation. 

b. Click Verify Input. 

 

5.  The Error field will now display the 
percentage of error of the verification.  

a. If the percentage of error is within 
acceptable limits, you do not need to 
re-calibrate the input channel.  

b. If the percentage of error is not within 
acceptable limits, you may need to 
re-calibrate the input channel (go to 
Section 7.2.2). 

c. Click End Verification to stop the 
process. 

 

 

Analog Output Verification 

To verify that the output calibration variables are correct or within the acceptable error tolerance, 
follow these instructions: 

1.  In the Actions ribbon, click Diagnostics. 

 

 
 

2.  Click on Calibration Verification in the 
Diagnostics tree. 
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3.  a. Click on the Analog Output tab. 
b. Select an analog output channel to 

verify from the Select Output 
drop-down box. 

 

To include output channels in the 
drop-down list that have not been assigned 
in the configuration, check the Include 
Unassigned I/O box. 

 

4.  If the channel has been assigned in the 
configuration, confirm that the Modbus 
Register Assignment, Remark and Values 
at 4 mA and 20 mA are displayed in 
blue text.  

 

 
 

 

If the Remark field is not filled in during the Analog output channel configuration, then 
the Modbus register’s database description, the hardware module and the Terminal 
Block pin numbers are still displayed in blue text after a selection is made. If the 
output channel is unassigned, only the hardware module and Terminal Block pin 
numbers are still displayed in blue text. 

5.  Connect an ammeter to the Terminal 
Block output pins in series between the 
flow computer and the external 4‒20 mA 
device. 

 

6.  When ready to begin the verification 
process, click Start Verification.  

 

 

7.  a. In the Verify Output group, enter an 
Analog Output Value. 

b. Click Apply Value. 

 

The flow computer will output the value 
using the current calibration constants. 

 

8.  a. Enter the value displayed on the 
ammeter in the Enter Reading field. 

b. Click Verify Output. 

 

This action records the following 
information in the Measurement 
Audit Trail Log: 

• Time, date and output index 

• Output # ‘n’ calibration start 
(n = output channel number) 

• User name, user ID and port 
hosting the calibration 
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9.  The Error field will now display the 
percentage of error of the verification.  

a. If the percentage of error is within 
acceptable limits, you do not need to 
re-calibrate the input channel.  

b. If the percentage of error is not within 
acceptable limits, you may need to 
re-calibrate the input channel (go to 
Section 7.2.2). 

c. Click End Verification to stop the 
process. 

 

 

7.2.4 System Information 

To access the flow computer’s general system information, follow these instructions: 

1.  In the Actions ribbon, click Diagnostics. 

 

2.  Click System Information in the 
Diagnostics tree to display the flow 
computer’s general system information 
screens to the right.  

 

The System Information tabs are detailed 
in the following sections: 

• Statement Results 

• User Prompts  

• Task Timings  

• Checksums  

• Firmware License  

 

Statement Results 

The Statement Results tab displays the results of previously configured Boolean and Variable 
statements. There are two lists: the first displays the Boolean statement results, and the second 
shows the Variable results (Figure 7-1). Any math or logic statements would be visible in 
these lists. 

 

Figure 7-1: Variable Statement Results Example 
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User Prompts 

The User Prompts tab displays the results of any previously-programmed user prompts (Figure 
7-2). 

 

Figure 7-2: User Prompts Example 

 

Task Timings 

The Task Timings tab shows a live feed of the different tasks the processor is processing every 
500 milliseconds or less (Figure 7-3). 

 

Figure 7-3: Task Timings Example 
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Checksums 

The Checksums tab shows the current firmware revisions and checksum calculations for the flow 
computer (Figure 7-4). The Operator can use this information to verify that the standard of 
certification is current (for example, the International Organization of Legal Metrology [OIML] 
Code) and to monitor any configuration changes. If the Metrological Configuration is updated, a 
red “Changed” box will appear beside it, and its status must be cleared. 

 

Figure 7-4: Checksums Tab 

 

Firmware License 

The Firmware License tab lists the optional features in the firmware that require a license. A 
green check mark indicates that the feature is available for use in the flow computer (Figure 7-5). 

 

Figure 7-5: License Revision Tab 

The Advanced Feature license package is available with Firmware versions 2.11 and higher. 
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7.2.5 System Resets 

To access the flow computer’s system reset options, follow these instructions: 

1.  In the Actions ribbon, click Diagnostics. 

 

2.  Click System Resets in the Diagnostics 
tree to display the flow computer’s system 
reset option screens to the right.  

 

The System Reset tabs are detailed in the 
following sections: 

• Reset Date and Time  

• Reset Single Channel Calibration  

• Reset Multiple Channel Calibration  

• Reset Prove  

• Reset Application  

• Reset RAM  

• Reset Totalizers  

 

Reset Date and Time 

The Reset Date and Time tab allows Operators the ability to manually set the flow computer’s 
date and time, or to synchronize with the PC’s current date and time by clicking the Get PC Date 
and Time button (Figure 7-6). 

 

Figure 7-6: Reset Date and Time Tab 
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Reset Single Channel Calibration 

To reset the channel if you have trouble calibrating an individual analog input or output channel, 
follow these instructions: 

1.  Click the Diagnostics button in the Home 
ribbon to open the Diagnostics tree in the 
left panel. 

 

Select System Resets in the left panel and 
then select the Reset Calibration tab in 
the screens to the right. 

 

 

 

 

 

2.  In the Reset Individual Calibration 
Constants section of the Reset 
Calibration screen: 

a. Select the Type radio button for the 
channel. 

b. Input the channel number in the 
Number field.  

c. Click Reset Calibration Constants.  

3.  At the prompt, click Yes to reset the 
channel. 

 

4.  After you reset the channel, you can 
attempt to calibrate the channel again. You 
can do this either through OMNICONNECT 
(Section 7.2.2) or the front panel 
(Section 7.3.2). 
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5.  If the problem persists:  

a. Check the hardware jumper settings 
for the channel in question.  

b. Check the software configuration 
settings to verify that they are set to 
the same type of input or output as the 
hardware jumpers. 

c. Contact the OMNI Help Desk at 
helpdesk@omniflow.com or call 
+1 281-240-6161.  

 

Reset Multiple Channel Calibration 

Use the option to reset multiple channels when: 

• Project-specific requirements necessitate resetting all channels before beginning calibration. 

• Multiple input or output channels will not calibrate correctly.  

To reset multiple channels simultaneously, follow these instructions: 

1.  For multiple calibration resets, click the 
appropriate button: 

• Reset All Calibration for resetting all 
Inputs and Outputs 

• Reset All Process Inputs for resetting 
analog inputs only 

• Reset All Analog Outputs for 
resetting analog outputs only 

 

2.  At the prompt, click Yes to reset 
multiple channels. 

 

3.  After you reset the channels, you can 
attempt to calibrate them again. You can 
do this either through OMNICONNECT 
(Section 7.2.2) or the front panel 
(Section 7.3.2). 

 

4.  If the problem persists:  

a. Check the hardware jumper settings 
for the channel in question.  

b. Check the software configuration 
settings to verify that they are set to 
the same type of input or output as the 
hardware jumpers. 

c. Contact the OMNI Help Desk at 
helpdesk@omniflow.com or call 
+1 281-240-6161. 

 

mailto:helpdesk@omniflow.com
mailto:helpdesk@omniflow.com
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Reset Prove 

The Reset Prove tab gives the Operator the ability to delete historical Meter Factor data for all or 
some of the Meter Runs. The following information is reset: 

• Meter Factor History (last 10 implementations) of most recently proved Meter: 

− Date (4945 – 4954) 

− Meter Factor and Deviation: (8589 and 8590 – 8607 and 8608) 

• Last Meter Factor implementation information: 

− Temperature – 7945 

− Pressure – 7946 

− Density – 7948 

− Flow Rate – 7966 

− Density at Ref Temp/RD60 – 7944 

• Meter Factor in use at last Meter Factor implementation – 8728 

• Net or Mass (if Meter is mass pulses) Totalizer at last Meter Factor implementation – 5924 

• IV Totalizer at last Meter Factor implementation – 5925  

Click any individual Meter Run button (#1 through 6) to reset only that Meter Run’s prove data or 
click “All Meters” to reset them all at the same time (Figure 7-7). 

 

 

Figure 7-7: Reset Prove Tab 
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Reset Application 

 

CAUTION:  

If you choose to change any application feature through this screen, it will clear any 
current settings and you will have to re-configure the flow computer. If this action is 
necessary, save a copy of the current configuration file before you reset any 
applications. 

The Reset Application tab allows the Operator to change the flow computer’s application of the 
firmware (Figure 7-8). 

 

Figure 7-8: Reset Application Tab 

 

Reset RAM 

 

CAUTION:  

Do not clear the flow computer’s Random Access Memory (RAM) unless you have 
verified that all important information has been saved through OMNICONNECT. 
Clearing the RAM will erase important operating information such as: 

• Configurations 

• Live process inputs 

• Registers 

• Totalizers and calibration data (in some cases) 

 

The only data kept after a full system reset is the current firmware revision. 

The Reset RAM tab has two options: clear only the configuration data or clear the entire RAM 
from the flow computer (Figure 7-9). 

 

 

Figure 7-9: Reset RAM Tab 
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Reset Totalizers 

 

You can only reset the totalizers if there is no flow in either the individual Meter Run 
you wish to reset, or in all Meter Runs if you want to reset all of them at the same 
time. 

To reset totalizer decimal resolutions, follow these instructions: 

1.  Confirm there is no flow to the meter(s) or 
station(s) you want to reset. 

 

2.  In the Actions ribbon, click Diagnostics. 

 

3.  Expand the System Resets option in the 
Diagnostics tree and click on Totalizer 
Resets.  

 

To reset all totalizers, continue to Step 4. 

To reset individual Meter Runs and 
Stations, continue to Step 7. 

 

 

 

 

 

 

 

4.  To reset all totalizers, in the Reset 
Totalizers tab click on the Reset All 
Totalizers button. 

 

 

Press F1 to access 
OMNICONNECT Help 
for more information 
on how the flow 
computer resets 
totalizers. 
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5.  a. In the Totalizer Digits window, select 
the number of Totalizer Digits and 
Totalizer Decimal Places, as 
needed. 

b. Click OK. 

 

 

6.  At the prompt, click Yes. 

 

7.  To reset individual Meters or Stations: 

a. Click on the tab of the Meter Run or 
Station you want to reset. 

b. Click the Reset Totalizers button to 
apply the changes you made in the 
Reset Totalizers tab. 

 

8.  At the prompt, click Yes. The totalizers will 
reset to zero (0). 
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7.2.6 Test Communications 

If you need to troubleshoot communication issues by determining the proper way to access 
certain Modbus register types, the Test Communications function acts as a Modbus master 
simulator where you can read and write the data to an individual register. 

To use the test communications application, follow these instructions: 

1.  In the Actions ribbon, click Diagnostics. 

 

2.  Click on Test Communications in the 
Diagnostics tree. 

 

3.  Use the options at the top of the screen to define the data register you wish to test. 

 

4.  a. Click the Transmit button to send the test message to the flow computer. You should 
receive back Data Values, the Transmit Message, and a Receive Message. 

b. Click the Repeat button to send the message continuously. You can edit how fast it 
repeats in the Repeat Delay field. 
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5.  To record and save the test, click the 
Register List button. This opens the 
Register List window.  

 

Keep the window open; you can still 
interact with the Test Communications 
screen in OMNICONNECT while the 
Register List is active. 

 

 

6.  With the previous test information still on 
the screen (and the Register List window 
still open), click the new Add to List 
button. 

 

Now the test information is listed in the 
window.  

 

 

7.  a. To test a different register, click back on the screen and change the register 
parameters.  

b. Click Transmit again to send the new message. 
c. Click Add to List again to add the new test to your Register List. 
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8.  a. To edit a previous register test, 
double-click on the test in your 
Register List. When it is highlighted 
in blue, press the Edit button. You 
can also right-click it and select Edit.  

b. Make changes on the Test 
Communications screen.  

c. When finished, press the Apply Edit 
button and it will be updated on the 
Register List screen. 

d. Click on your next action: Transmit, 
Repeat, Edit, etc.  

 
 

 

 

Select multiple registers for editing in the Register List window and the edits will 
be applied to all highlighted registers. You can also copy, move and delete items 
from the Register List. 

9.  a. To save your Register List for future 
reference, click the Save to File 
button. 

b. Select a place to save the file on the 
PC or use the default RegList 
location OMNICONNECT 
automatically creates. You can also 
set this folder in your Preferences 
(Setup ribbon > Preferences button > 
Register List tab). 

c. Name the file, and click Save. 

 

 

 

7.3 Front Panel Maintenance 

7.3.1 System Date/Time 

To access and configure the system date and time settings, follow these instructions: 
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1.  a. In the Home menu, use the arrow 
navigation keys to go to and select 
Utilities. 

b. Press the OK key. 

 

2.  With System Date/Time highlighted, press 
OK. 

 

3.  a. Use the arrow keys to select the 
variable you wish to edit. 

b. Press OK to access the field and 
make changes.  

c. Press OK or the Accept function key 
to save your changes. 

 

4.  a. Continue to view or edit date and time 
settings, as needed.  

b. When finished, press the Back key to 
return to the Utilities screen or the 
Home key to return to the Home 
screen. 

 

7.3.2 Calibration 

Input Calibration 

 

The options to calibrate by variable name (for example, ‘Temperature’), will not be 
selectable under the six individual Meter Runs or the two Stations or the prover until 
input channels have been assigned to them in OMNICONNECT. 

To calibrate the input channels, follow these instructions: 
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1.  a. From the Home screen on the front 
panel display, use the arrow keys to 
navigate to and select Utilities. 

b. Press the OK key. 

 

2.  a. On the Utilities screen, use the arrow 
keys to navigate to the Calibration 
menu selection. 

b. Press OK. 

 

3.  With Input Calibration highlighted, press 
OK. 

 

 

The Process Input Calibration screen includes a horizontal Input bar at the top with 
these options: 

• Process Input (PI) allows you to calibrate by channel number selection  
(for example, 1 through 32). 

• Numbers 1 through 6 allow you to calibrate using a process input variable name 
for individual Meters 1 through 6 (for example, Meter 1 Temperature or Meter 5 
Density Pressure).  

• S1 and S2 allow you to calibrate using a process input variable name for 
Individual Station 1 and Station 2 (for example, Station 1 Density Temperature or 
Station 2 Density Pressure). 

4.  Use the arrow navigation keys to select an 
option on the Input bar; then press OK.  
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5.  Use the Up or Down arrow navigation 
keys to scroll through the available 
channels or variables to calibrate. 

 

a. Press OK or the Accept function key 
to continue. 

b. Press the Cancel function key to 
abort the calibration process. 

 

 

 

6.  Use the Up or Down arrow navigation 
keys to scroll to each field.  

 

Press OK to enter the edit mode for the 
selected field, and edit the values or 
selections as needed: 

a. Choose the Calibration Units from 
the drop-down list (for example, 
mA, Ohms). 

b. Type in the desired Override Value 
in engineering units. 

 

After editing each field, press OK or the 
Accept function key to continue. 

  

 

• Selected Input? displays the channel number or process variable name selected 
for calibration.  

• Calibration Units? appears only after an input has been selected.  

• Override Value? will not appear under the PI menu selection if the channel 
number has not yet been assigned in the flow computer configuration. The flow 
computer will use the engineering value in its flow calculations while the input 
channel is being calibrated. 

7.  Verify that the signal wiring is properly 
connected to the appropriate input channel 
at the Terminal Block on the flow computer 
back panel. 

 

8.  Press the Start function key to begin 
the calibration.  
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9.  Adjust the Signal Generator or configure 
the Transmitter (whichever is connected) 
to output the appropriate Low value 
according to the selected calibration units. 

 

 

10.  Confirm that the Live Input (mA/Ohms) 
field value is close to the applied value 
from the field transmitter or 
signal generator.  

 

If the value is not close to the applied 
value, check: 

• The wiring is connected to the 
correct channel. 

• The hardware jumper settings. 

 

 

See the following sections in the Installation Guide for more information on wiring and 
jumper settings: 

• Section 3.7.5 Process I/O Modules for tables on back panel wiring. 

• Appendix A: Jumper Settings for hardware jumper settings. 

11.  Wait 20 to 30 seconds for the readings to 
stabilize. 

 

12.  While the Applied Input Value? field is 
highlighted, press OK.  

 

13.  Using the numeric keypad, enter a value 
that exactly matches the value at the field 
transmitter or the signal generator.  

 

Press OK.  

 

Low values are 4.00 mA for a  
4‒20 mA input, 1 V for a 1‒5 V 
input, and 25 ohms for an 
RTD input. 



OMNI 4000/7000 Operations and Maintenance Guide – Rev F 

 
7-28 Maintenance 

 
 

14.  Press the Apply Low function key to 
complete the Low adjustment or the Abort 
function key to discard. 

 

15.  Adjust the Signal Generator or configure 
the Transmitter, whichever is connected, 
to output the appropriate HI value 
according to the selected calibration units. 

 

 

16.  Confirm that the Live Input (mA/Ohms) 
field value in the Apply High Input 
Source screen is close to the applied 
value from the field transmitter or 
signal generator.  

 

If the value is not close to the applied 
value, check: 

• The wiring is connected to the correct 
channel. 

• The hardware jumper settings. 

 

17.  Wait 20 to 30 seconds for the readings to 
stabilize. 

 

18.  While the Applied Input Value? field is 
highlighted, press OK.  

 

19.  Using the numeric keypad, enter a value 
that exactly matches the value at the field 
transmitter or the signal generator.  

 

Press OK.  

 

High values are 20.00 mA for a  
4‒20 mA input, 5 V for a 1‒5 V 
input, and 150 ohms for an 
RTD input. 
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20.  Press the Apply HI function key to 
complete the span adjustment or the 
Abort function key to discard. 

 

21.  After pressing the Apply HI function key, 
the Finalize Calibration? screen displays. 

 

a. If you have trouble calibrating the 
input channel, reset the channel by 
pressing the Defaults function key; 
then attempt to calibrate the 
channel again. 

b. Press the Yes function key to finalize 
the calibration of the input channel. 

c. Press the No function key to discard 
the calibration changes. 

 

22.  Continue calibrating additional input 
channels as needed by repeating 
these steps.  

 

Output Calibration 

To calibrate the 4‒20 mA output channels, follow these instructions: 

1.  a. From the main menu of the front 
panel, select Utilities and press OK.  

b. Select Calibration, press OK. 

c. Select Output Calibration.  

 

2.  Press OK to enter the edit mode of the 
Selected Output? field. 
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3.  Use the Up or Down arrow keys to scroll 
through the list of output channels.  

 

4.  Press the Cancel function key to abort the 
calibration process or press OK or the 
Accept function key to select the 
highlighted channel.  

 

 

 

5.  Connect an ammeter in series between 
the flow computer and the external  
4‒20 mA device.  

 

6.  Press the Start function key to begin the 
calibration process.  

 

7.  Confirm that the next screen shows the 
Output Value (mA) field default of 4.00.  

 

8.  Wait 20 to 30 seconds for the readings to 
stabilize. 

 

9.  Note the value indicated on the ammeter.   
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10.  Use the front panel to key in the value that 
appears on the ammeter: 

a. Select the Measured Output (mA)? 
field. 

b. Press OK.  

c. Enter the value.  

d. Press OK again or the Accept 
function key. 

 

11.  If needed, press the Abort function key to 
cancel the calibration. 

 

To continue to the 20 mA calibration 
screen, press the Apply Low 
function key.  

 

The next screen shows the Output Value 
(mA) field default of 20.00.  

 

12.  Wait 20 to 30 seconds for the readings to 
stabilize. 

 

13.  Note the value indicated on the ammeter.   

14.  Use the front panel of the flow computer to 
key in the value displayed by the 
ammeter: 

a. Select the Measured Output (mA)? 
field. 

b. Press OK. 

c. Enter the value.  

d. Press OK again or the Accept 
function key. 

 

15.  If needed, press the Abort function key to 
cancel the calibration. 

 

To continue to the Finalize Calibration 
screen, press the Apply HI function key. 

 



OMNI 4000/7000 Operations and Maintenance Guide – Rev F 

 
7-32 Maintenance 

 
 

16.  a. If you have trouble calibrating the 
output channel, reset the channel by 
clicking the Defaults function key 
and attempt to calibrate the 
channel again. 

b. Press the Yes function key to finalize 
the calibration of the output channel. 

c. Press the No function key to discard 
the calibration changes. 

 

17.  Continue calibrating additional output 
channels by repeating Steps 1 through 16. 

 

7.3.3 Calibration Verification 

Input Verification 

To verify that the input calibration variables are correct or within the acceptable error tolerance 
and so do not require calibration, follow these instructions: 

1.  a. From the main menu of the front 
panel, select Utilities and press OK.  

b. Select Calibration, press OK. 

c. Select Input Verification.  

 

2.  Use the arrow navigation keys to select an 
option on the Input bar; then press OK.  

  

 

The Process Input Verification screen includes a horizontal Input bar at the top 
with these options: 

• PI allows you to calibrate by process input channel number selection  
(for example, 1 through 32). 

• Numbers 1 through 6 allow you to calibrate using a process input variable name 
for individual Meters 1 through 6 (for example, Meter 1 Temperature or Meter 5 
Density Pressure).  

• S1 and S2 allow you to calibrate using a process input variable name for 
Individual Station 1 and Station 2 (for example, Station 1 Density Temperature 
or Station 2 Density Pressure). 
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3.  Use the Up or Down arrow navigation 
keys to scroll through the available 
channels or variables to verify. 

a. Press OK or the Accept function key 
to continue. 

b. Press the Cancel function key to 
abort the verification process. 

 
 

 

4.  If you are verifying a value other than the 
default (mA) unit, use the arrow navigation 
keys to scroll down and highlight 
Calibration Units?.  

a. Press OK to open the field box and 
use the arrow keys again to scroll 
through the options and choose a 
different unit (Volts, Ohms or degF). 

b. When the new unit is selected, 
press OK. 

 

5.  a. Scroll to and highlight Override 
Value?.  

b. Press OK.  
c. Enter the Override Value you want to 

use for this verification test. 
d. Press OK to save the entry. 

 

6.  Press the Start function key to begin the 
Input Verification test. 
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7.  On this screen you are given the flow 
computer’s Live Input Value. At any time, 
you can: 

a. Press the Save&Log function key to 
save and log the input verification 
test in the Measurement Audit Trail 
Report. 

b. Press the Exit function key to stop 
the input verification process and 
return to the Input Verification 
screen in Step 2. 

 

8.  Now you can vary the input value and 
compare it with the flow computer’s value 
by entering an Applied Input Value. 

a. While Applied Input Value? is 
highlighted, press OK to open the 
entry field. 

b. Enter your Applied Input Value. 
c. Press OK.  

9.  The flow computer now gives you a 
% Error based on the Applied Input 
Value you entered. You can: 

a. Press the Save&Log function key to 
save this entry. 

b. Press OK to enter a new Applied 
Input Value and complete a different 
input verification test. 

c. Press the Exit function key and exit 
the process. 

 

Output Verification 

To verify that the output calibration variables are correct or within the acceptable error tolerance, 
follow these instructions: 

1.  a. From the main menu of the front 
panel, select Utilities and press OK.  

b. Select Calibration; press OK. 

c. Select Output Verification.  
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2.  Press OK to enter the edit mode of the 
Selected Output? field. 

  

3.  Use the Up or Down arrow keys to scroll 
through the list of output channels.  

 

Press the Cancel function key to abort the 
calibration process or press OK or the 
Accept function key to select the 
highlighted channel.  

 
 

4.  Connect an ammeter in series between 
the flow computer and the external  
4‒20 mA device.  

 

5.  Press the Start function key to begin the 
verification process.  

 

6.  Use the front panel to key in the value 
originally calibrated (the default is 4 mA): 

a. Select the Output Value (mA)? field. 

b. Press OK.  

c. Enter the value.  

d. Press OK again or the Accept 
function key. 

 

7.  If needed, press the Exit function key to 
cancel the calibration. 

 

8.  Now key in the value that appears on the 
ammeter: 

a. Select the Measured Output (mA)? 
field. 

b. Press OK.  

c. Enter the value.  

d. Press OK again or the Accept 
function key.  
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9.  Press the Save&Log function key to both 
run the verification process and log it in 
the flow computer’s Measurement Audit 
Trail Report. 

 

10.  The verification screen now displays the 
Error Output (%).  

 

If this percentage is within your acceptable 
error tolerance, you do not need to 
re-calibrate the analog output channel. If it 
is not, go to Output Calibration in Section 
7.3.2 and follow the instructions to 
re-calibrate the flow computer. 

 

11.  Press the Exit function key to return to the 
Analog Output Verification screen to 
choose a different output to verify, or to 
use a different value. 

 

7.3.4 Maintenance Mode 

Placing the flow computer in Maintenance Mode gives operators the ability to verify Meter Run 
calculations without adversely affecting the overall operation of the normal totalizers. 
Maintenance Mode freezes all analog inputs so that maintenance can be completed on 
transmitters without affecting any process variables used during normal mode calculations. 

To access the Maintenance Mode through the front panel, follow these instructions: 

1.  a. In the Home menu, use the arrow 
navigation keys to go to and select 
Utilities. 

b. Press the OK key. 
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2.  a. On the Utilities screen, use the arrow 
keys to navigate to the Calibration 
menu selection. 

b. Press OK. 

 

3.  a. Use the arrow keys to scroll down and 
highlight Maintenance Mode. 

b. Press OK. 

 

4.  Maintenance Mode is disabled by default. 
Use the right and left arrow keys to 
navigate to different Meter Runs, if 
needed. 

 

When ready to enable Maintenance Mode, 
press the FR/Totals function key. 

 

5.  The Maint Mode Flow/Totals screen 
displays a list of all the flow rates and 
totalizers you can adjust in this mode.  

 

Press the Set Res function key to enter 
new decimal resolutions. 

 

6.  Use the Up and Down arrow navigation 
keys to scroll to and highlight the flow or 
totalizer decimal resolution you wish to 
change and press OK to open the entry 
field. 

 

7.  Enter the new value for your selection and 
press OK. 
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8.  Continue entering new values, as needed. 
When finished, press the Back key to go 
back to the Maint Mode Flow/Totals 
screen. 

 

 

 

 

9.  On the main Maint Mode Flow/Totals 
screen, press the red Reset Tot function 
key to reset the totalizer values to zero. 

 

This does not affect the decimal 
resolutions set in Step 6; they can only be 
changed manually. 

 

10.  a. When ready to reset the Maintenance 
Mode totals, press OK and use the 
Up and Down arrow keys to change 
the status from Ready to Execute. 

b. Press OK again to start the reset. 

 

 

11.  When the reset is complete, the status 
automatically returns to Ready. Press the 
Back key to go back to the Maint Mode 
Flow/Totals screen and continue in 
Maintenance Mode, or the Home button to 
return to the main menu. 
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7.3.5 System Resets 

 

CAUTION: 

Do not clear the flow computer’s RAM unless you have verified that all important 
information has been saved through OMNICONNECT. Clearing the RAM will erase 
important operating information such as: 

• Configurations. 

• Live process inputs. 

• Registers. 

• Totalizers and calibration data (in some cases). 

 

The only data that is kept after a system reset is the current firmware revision. 

The purpose of the System Resets function is to clear the flow computer’s RAM. 

To access the System Resets, follow these instructions: 

1.  a. In the Home menu, use the arrow 
navigation keys to go to and select 
Utilities. 

b. Press the OK key. 

 

2.  a. Use the arrow keys to scroll down and 
highlight System Resets. 

b. Press OK. 

 

3.  If you are ready to clear the RAM and have 
all pertinent information saved to another 
location through OMNICONNECT, 
press OK. 
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7.3.6 Licensing 

To access the flow computer’s firmware license information through the front panel (software 
license information can be found in OMNICONNECT), follow these instructions: 

1.  a. In the Home menu, use the arrow 
navigation keys to go to and select 
Utilities. 

b. Press the OK key. 

 

2.  a. Use the arrow keys to scroll down and 
highlight Licensing. 

b. Press OK. 

 

3.  You can now view your flow computer’s 
current licenses for optional firmware 
features on the License Information 
screen. 

 

7.3.7 Disable Download 

The Disable Download function controls the ability of the flow computer to either transmit or 
receive a configuration file. 

To access the Disable Download settings, follow these instructions: 

1.  a. In the Home menu, use the arrow 
navigation keys to go to and select 
Utilities. 

b. Press the OK key. 
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2.  a. Use the arrow keys to scroll down and 
highlight Disable Download. 

b. Press OK. 

 

3.  The default setting for the Disable 
Download function is No. 

 

Press OK to select the option box and use 
the up or down arrow keys to change it 
to Yes. 

 

 

 

7.3.8 Communications 

 

See Section 4.3 Configuring Communications Ports (Front Panel) in the Installation 
Guide to configure Serial and Ethernet ports. 

7.3.9 Check Modules 

To properly allocate any changes to the hardware’s I/O channels for later configuration and 
assignment using the OMNICONNECT software, follow these instructions: 

1.  a. From the Home screen on the front 
panel display, use the arrow navigation 
keys to go to and select Utilities. 

b. Press OK. 

 

The No setting means the flow 
computer can receive entire 
configurations. The Yes setting 
means that it cannot receive them, 
and any changes must be made in 
individual configuration screens 
while online. 
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2.  a. On the Utilities screen, navigate to the 
Check Modules menu selection. 

b. Press OK or the Enter key. 

  

3.  a. Verify that the SW (Software) and HW 
(Hardware) columns both display Y 
(Yes) for each module.  

b. Use the Pg Down or Pg Up function 
keys to scroll up or down the screen to 
view all the modules, as necessary. 

c. If the SW and HW columns display all 
Ys, then you are finished. 

d. If modules show N (No) under either 
the SW or HW columns, press the 
Execute function key. 

 

 

4.  Press the Confirm function key to proceed 
with the Check Modules command so that 
all installed modules show Y under both the 
SW and HW columns. 

 

The flow computer detects any 
changes in the hardware modules 
installed. 

Do not be concerned if not all of 
the modules show a value under 
the IRQ (Interrupt Request) 
column. The IRQ is fixed for some 
modules. 
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5.  a. Confirm that any modules that 
previously said N under the SW 
column now say Y, indicating that their 
software has been updated to reflect 
the hardware installation. 

b. Confirm that any modules that 
previously showed N under the HW 
column no longer appear on the 
screen after the list has been updated, 
which indicates that the module has 
been removed.  

 

 

6.  When complete, press the Back key to 
return to the Utilities screen. 

 

7.3.10 Secure Digital Card 

The Secure Digital (SD) card stores all data from the flow computer. If the card is full or there is a 
problem and it needs to be replaced, the flow computer will give an error message. 

To eject an SD card and format a new card, follow these instructions: 

1.  a. In the Home menu, use the arrow 
navigation keys to go to and select 
Utilities. 

b. Press the OK key. 

 

2.  a. Use the arrow keys to scroll down and 
highlight SD Card. 

b. Press OK. 

 

3.  On the flow computer CPU module, 
physically remove the protective adhesive 
tape covering the SD card slot. 

 

In this example, the E-2 module 
has been physically removed from 
the flow computer, and after 
performing the Check Modules 
function, it no longer appears in 
the module list. 
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4.  a. Press the Eject function key. 
b. Remove the old SD Card. 
c. Insert the new SD Card. 
d. Press the Format button. 

 

5.  On the flow computer CPU module, 
replace the protective adhesive tape 
covering the SD card slot. 

 

6.  a. When you are ready to format the 
newly-inserted SD Card, press the 
Confirm button. 

b. Press Abort to exit the Format 
screen. 

 

 

 

Pressing the Confirm button will 
erase anything currently on the 
new SD Card. Once a new SD 
card has been formatted, the flow 
computer will no longer be able to 
access the previous SD card’s 
data if it is reinserted. 
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7.3.11 Diagnostic Data 

These screens display diagnostic information about the flow computer such as number and type 
of I/O modules installed, current output percentage of analog outputs and raw input signals 
coming into the flow computer. 

To access the Diagnostic Data information, follow these instructions: 

1.  a. In the Home menu, use the arrow 
navigation keys to go to and select 
Utilities. 

b. Press the OK key. 

 

2.  a. Use the arrow keys to scroll down and 
highlight Diag Data. 

b. Press OK. 

 

3.  Use the arrow keys to navigate to any of 
the three selections and press OK to view 
their data. 

 

 

 

 

NMi Data is a special screen of 
information required for the flow 
computer to receive the NMi 
certification for measuring 
instruments.  
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7.4 Component Maintenance 

 

If maintenance needs to be completed on any component of the OMNI 4000/7000 
flow computer while it is in operation, inform the responsible technicians according 
to your company- or project-specific procedures. Only qualified individuals should 
perform maintenance on these components. 

 

Contact the OMNI Sales Department at Sales@omniflow.com or +1-281-240-6161 
to inquire about purchasing replacement parts for the following components: 

• Fuse kits 

• Modules 

• Cables  

 

7.4.1 Inspection 

 

See Section 7.2 Troubleshooting Tables in the Installation Guide to verify that the 
hardware is operating normally and all alarms are cleared. 

As part of your company-specific scheduled maintenance program, you may conduct a visual 
inspection of the OMNI 4000/7000 components.  

To complete a visual inspection, follow these instructions: 

 

CAUTION: If there is any evidence of burnt components, or you need to access the 
flow computer enclosure to inspect the interior, verify the following before opening 
the flow computer: 

• OMNICONNECT configurations and reports have been saved.* 

• Flow in the pipe has been shut off.* 

• The flow computer has been powered off. 

*If required by your local procedures for taking the flow computer offline. 

 

Observe precautions for handling electrostatic-sensitive devices. 

1.  Make a visual inspection of the flow 
computer. Pay particular attention to the 
input channel on the module where the 
transducer is connected.  

 

2.  If you see any of the following problems, 
take corrective actions as defined by your 
project-specific or company-specific 
procedures: 

• Signs of burned components 

• Bent or broken pins 

• Moisture 

• Discoloration 

• Broken parts 

• Stress on any cables (For the Serial 
interface cables, check the jackets for 
loose wires, problems with insulation, or 
other signs of stress.) 

• Dust or foreign material 

mailto:Sales@omniflow.com
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3.  If you suspect that a DC or AC fuse is 
malfunctioning, go to Section 7.4.3 Fuse 
Service and Replacement.  

 

4.  Inspect the buttons on the front panel 
keyboard for blockage because of 
environmental conditions, such as dirt or 
salt build-up (when installed near the 
ocean), and clean them, if needed.  

 

 

 

CAUTION: If you apply a cleaning solution to the front panel, do not use a solvent 
cleaner. Solvent cleaners may further degrade the buttons on the front panel.  

5.  Verify that the protective tape holding the 
SD card in place is still functioning 
properly. If the adhesive has worn off and 
the tape needs to be replaced, contact the 
OMNI Help Desk at 
helpdesk@omniflow.com or call 
+1 281-240-6161. 

 

7.4.2 Change Modules 

If you want to add or remove a module, change the installed order of the modules, or simply 
replace a damaged card, complete the following instructions. 

Take the Flow Computer Out of Service 

1.  Follow your local procedures for taking 
the flow computer out of service, which 
may or may not include: 

• Stopping active flow of the product 
in the pipeline system connected 
to the flow computer. 

• Ending all batches, either remotely 
or manually (Step 2). 

• Saving configuration data 
(Steps 3 through 5). 

• Saving reports and archive data 
(Steps 6 and 7). 

 

When you have completed your local 
procedures, go to Step 8. 

 

If the buttons are too degraded or 
cannot be cleaned, the front panel 
may need to be replaced.  

mailto:helpdesk@omniflow.com
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2.  a. To end a batch through 
OMNICONNECT, go to Section 
3.6.4. 

b. To end a batch through the front 
panel, go to Batch Control/Ending 
a Batch in Section 6.6.5. 

 

3.  In OMNICONNECT, retrieve the 
current configurations and save the file 
to your PC: 

a. If not currently online with the flow 
computer, click the Online button 
and connect to the unit. 

b. In the Connect to OMNI window, 
choose which unit to connect with 
from the list presented. 

c. Enter the appropriate user name 
and password when prompted. 

 

 

 

4.  a. Click the Receive button in the 
Home ribbon to open the Receive 
Data from OMNI Unit window 
and receive the current 
configuration from the 
flow computer. 

b. Click Start to receive the data 
from the flow computer. 
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5.  a. Click on the File ribbon and select 
Save As… 

b. In the Save As window, enter a 
file name and navigate to a 
chosen location on your PC or 
use the default Omni folder. 

c. Click Save. 

 

 

 

6.  Before powering off the flow computer, 
you should also retrieve all archive 
reports through OMNICONNECT: 

a. In the Operate tree, click on the 
first Current Report: Snapshot. 

b. Click Save Report. 
c. Continue saving reports for all 

Current Reports and Historical 
Reports in the tree. 
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7.  Retrieve any raw archived data by 
following the instructions in Section 
5.3.3 Retrieve Archives, as applicable. 

 

If you are not running the archive data 
feature, you should still retrieve the 
Alarm, Measurement Audit and 
System Audit archives. 

 

8.  a. When you have finished retrieving 
and saving all relevant 
configurations, reports and data, 
click the Offline button. 

b. Close OMNICONNECT.  

9.  Power down the flow computer and 
verify that no voltages are present. 

 

 

WARNING: When working with external devices connected to the OMNI 4000/7000 
back panel, verify that no power is applied to the flow computer. External devices 
may have their own source of power. 

 

 

Earth Ground Requirements:  

Electrical shock can cause serious or fatal injury. Follow the National Electrical Code 
(NEC) and local codes for the safe operation and maintenance of this equipment. 
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Add, Remove and Replace Modules 

1.  If you are using the panel mount chassis, 
lift the Front Panel Bezel upwards to slide 
the inner chassis out. 

If you are using the NEMA chassis, remove 
the card-retaining bracket from the chassis. 

 

2.  Use the card ejector to remove the module 
from the chassis.  

Make note of the module’s designated slot 
number on the motherboard. 

 

 

If removing a CPU or power supply card, there will be cables to disconnect before 
you are able to remove the card from the chassis. Remember to re-connect these 
cables when putting in the new cards. 

3.  Insert the new module into its designated 
slot. 

 

4.  To reinstall the panel mount chassis, 
slowly slide the inner chassis back into the 
flow computer. 

 

For the NEMA chassis, re-install the 
card-retaining bracket. 

 

 

If you have added a module, removed a module or changed the order of the 
modules, go to the back panel wiring tables in Section 3.7 Connect to Field Devices 
in the Installation Guide to verify or re-configure the wiring. 

 

If you have replaced a module (with the same type of module), the back panel 
wiring does not change. 

5.  Power up the flow computer.  

6.  Go to Section 7.3.9 Check Modules and 
follow the instructions to complete the 
Check Modules feature. If any module 
indicates a N for NO under the Hardware 
or Software column, execute the Check 
Modules feature until all modules indicate 
Y for YES under both columns. 
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If you have added or replaced a Serial, DE or Digital Multiplexer module, when the 
flow computer powers up it will automatically check for and adjust the hardware 
configurations. With any other module card, you may receive a message upon 
connecting to the flow computer in OMNICONNECT stating that there is a mismatch 
and you need to run Check Modules. It is good practice to manually run Check 
Modules regardless of whether you receive this message or the type of module you 
add or replace. 

 

 

Verify Configuration 

Adding, removing or changing the order of modules may clear your previous I/O assignments and 
reallocate the input and output channels to fit the new module order, or even clear all 
configuration settings. You must now review all configurations in the flow computer and re-assign 
any input channels that were cleared by your previous actions. 

1.  a. Open OMNICONNECT. 
b. Follow Steps 3 and 4 above to go 

online with the flow computer and 
retrieve the data.  

 

 

If upon retrieving the data you discover that your previous configurations have been 
cleared, you can open a previously-saved configuration file. Go to File > Open and 
navigate to the correct file. Adjust the new configuration to match any old settings 
that still apply and change new settings as necessary (such as updating DCFs and 
MFs). 

2.  a. In the Actions ribbon, click on 
Configure. 

b. Click on General Setup in the 
Configure tree. 

 

 



OMNI 4000/7000 Operations and Maintenance Guide – Rev F 

 
7-53 Maintenance 

 
 

3.  Beginning with the first General Setup tab, 
review all configurations and input 
assignments: 

a. Expand every expandable item in the 
Configure tree. 

b. One by one, select every item in the 
tree and review each configuration 
screen and tab. 

c. Re-assign input channels, as 
necessary 

d. Make adjustments to configurations, 
as necessary. 

 

 

Pay particular attention to the items in the OMNI I/O folder, as most potential 
changes or updates will involve the flow computer’s input and output assignments. 
The Modules screen displays an overview of the installed modules and current 
I/O allocations. 

 

 

4.  Follow your local procedures for placing 
the flow computer back into service, which 
may or may not include: 

• Starting the archiving raw data feature 
(Step 21). 

• Starting batches and initiating flow in 
the pipes through PID loops (Step 22). 

• Notifying the responsible persons that 
the maintenance is complete (Step 23). 
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5.  If you want to begin archiving raw data 
again, go to Section 5.3.2 and follow the 
instructions for starting this feature if it has 
stopped. 

 

6.  If you are using PID Loops, start your 
batches or open the pipeline system valves 
and initiate flow through PID Control (go to 
Startup and Shutdown Ramping Functions 
in Section 6.6.6). 

 

7.  If you are not using PID Loops to start the 
batches, notify your SCADA operator or 
technician to initiate flow. 

 

7.4.3 Fuse Service and Replacement 

Specifications 

Fuses are located on the panel mount and short extended back panels (Table 7-1) or extended 
back panels (Table 7-2).  

Table 7-1: Power Fuse Specifications 

Location Specifications 

• Standard Back Panel 
(4000/7000) 

• Short Extended Back Panel 
(7000) 

• AC Fuse 5x20 = 1.6 A Fast Blow 
(Littelfuse #021701.6) 

• DC Fuse 5x20 = 3.15 A Slow Blow 
(Littelfuse #02183.15) 

 

Table 7-2: NEMA Mount Power Fuse Specifications 

Location Specifications 

Extended Back Panel (7000) • AC Fuse 5x20 = 1.6 A Fast Blow 
(Littelfuse #021701.6) 

• DC Fuse 2AG = 3 A Slow Blow 
(Littelfuse #0229003) 

• Transducer Loop power fuses 1 through 8 
DC Fuse 2AG = 250 mA Fast Blow  
(Littelfuse #0225.250) 
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Test and Replace Fuses 

 

Note the part number on any fuse you plan to replace and use the specifications in 
Table 7-1 and Table 7-2 to verify that you are installing the correct fuse with the 
matching part number.  

If power is being provided to the flow computer but the flow computer is not on, or the flow 
computer is providing power to an outside device and that device is not on, there could be a 
problem with a fuse.  

Test a suspected malfunctioning fuse by measuring across it with a multi-meter to test continuity. 
If the fuse tests “Open,” it may need to be replaced.  

To remove and replace a suspected malfunctioning fuse, follow these instructions: 

1.  Follow your local procedures for taking the 
flow computer out of service. Go to Section 
7.4.2 for further instructions on saving 
configurations, ending batches and 
archiving data, if needed. 

 

2.  Power down the flow computer.  

 

WARNING: When working with external devices connected to the OMNI 4000/7000 
back panel, verify that no power is applied to the flow computer. External devices 
may have their own source of power. 

 

 

Observe precautions for handling electrostatic-sensitive devices. 

3.  Verify that the power to the flow computer 
is OFF. 

 

4.  Access the back panel or extended back 
panel: 

• For panel mount and short extended 
back panel devices, go to Step 5. 

• For extended back panel devices, go 
to Step 8. 

 

5.  Both fuses on the panel mount back panel 
and the short extended back panel are 
1/4 turn cartridge fuses that can be 
unscrewed by hand. 

 

By hand, carefully apply downward 
pressure and turn the base of the fuse 
holder counter-clockwise to remove the 
fuse. 
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6.  a. Replace the malfunctioning fuse with 
a new one, following the 
specifications for the Standard Back 
Panel indicated in Table 7-1.  

b. Carefully apply downward pressure 
and turn the base of the fuse holder 
clockwise to re-install the fuse. Do not 
over-tighten (the fuse holder will stop 
when tightened sufficiently). 

c. Verify that the fuse cartridge is fully 
seated. 

 

7.  Repeat Steps 5 and 6 for the second fuse, 
if needed.  

 

When finished, go to Step 16 to complete 
the fuse maintenance. 

 

8.  The standard extended back panel has 
one 1/4 turn AC cartridge fuse, one DC 
power fuse and eight loop power fuses 
(F1–F8) that are installed in clips (Table 
7-2): 

a. For the AC cartidge fuse, go to 
Step 9. 

b. For the clip-installed fuses, go to 
Step 11. 

 

9.  a. To remove the AC cartridge fuse, use 
a flat-head screwdriver and insert the 
head into the slot at the top of the 
fuse holder.  

b. Apply downward pressure and turn 
the screwdriver counter-clockwise to 
remove the fuse. 

 

10.  a. Replace the malfunctioning fuse with 
a new one, following the 
specifications for the AC 5x20 fuse 
indicated in Table 7-2.  

b. Carefully use the screwdriver to apply 
downward pressure and turn the fuse 
holder clockwise. Do not over-tighten. 

c. Verify that the fuse cartridge is fully 
seated. 

 

11.  To remove a clip-installed fuse, disconnect 
its power connections to the field device 
before removing the fuse. 
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12.  Place the flat end of the screwdriver 
underneath the fuse in between the clips 
and carefully pop out the fuse from the 
clips.  

 

13.  a. Replace the malfunctioning fuse with 
a new one, following the 
specifications for the Extended Back 
Panel DC 2AG fuses indicated in 
Table 7-2.  

b. Place the terminals of the fuse on top 
of each clip and carefully press down 
to seat the fuse into place. 

 

14.  Re-connect the fuse’s power connections 
to the field device that you removed in 
Step 11. 

 

15.  Repeat Steps 11 through 14 for any other 
clip-style fuse, if needed.  

 

When finished, continue to Step 16 to 
complete the fuse maintenance. 

 

16.  Power up the flow computer.  

17.  Follow your local procedures for placing 
the flow computer back into service and 
verify that all functions are 
operating normally. 

 

 

If after you replace a suspected malfunctioning fuse and the original situation that 
prompted the replacement has not changed, the problem may lie with an external 
device.  
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